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Introduction

Features

packVol is a powerful load planning software. The application has no limits on the
number of containers, or on the total number of different package items, or on the
total number of packages it can manage, which are limited only by the available
memory. The program is extremely fast and can optimize space utilization for load
plans with thousands of packages in fractions of a second on a common personal
computer.

packVol can operate in two distinct modes, automatic and manual:

• In automatic mode the load plan is evaluated by the internal optimizer
of the program;

• In manual mode the load plan is defined by the User, thanks to a 3D
graphical environment having the most common editing functions: select,
copy, paste, cut, undo, redo, zoom, pane, etc..

To simplify data entry operations packVol has,

• an internal database where you can store container and package data;

• filters to import from Excel file or from ODBC data sources.

packVol offers many functions for saving data, creating reports and exporting data.

Versions

The application is available in three versions: LITE [LTE], STANDARD [STD] and
DYNLOAD [DYN]. Check out the Versions online page for a description of the
main features of each edition, the most appropriate scope of use, and the analytical
comparison table of available features.

System requirements

MS Windows c⃝: The program has been tested on Windows Vista, Windows 7, Win-
dows 8/8.1, Windows 10/11, Windows Server 2012, Windows Server 2016, Windows
Server 2022. Minimum requirements:

• 233 MHz processor or higher;

• 64 MB RAM memory;

c⃝ 2003-2024 Antimo Angelucci - packVol.com To my wife and my daughter,

for their infinite patience

https://www.packvol.com/versions.html
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• Video card with 16 bit color depth or higher. A screen resolution of
1024x768 or higher is recommended. Resolutions lower than 1024x768
are not supported;

• 3D graphics acceleration is not required but highly recommended if you
want to use the manual mode;

• 22 MB of free space on hard disk.

Installation

MS Windows c⃝: a setup program will install the application and configure your
system. You can easily uninstall the program by invoking the “Windows Control
Panel”, by double-clicking on “Add/Remove Programs”, and then by choosing the
“packVol” item.

The non-registered evaluation version is fully functional for 30 days after the first
installation.

Getting Started

For information on using the program, check out the Tutorials available online,
which guide you step by step in learning how the program works, with simple but
concrete examples of use.

https://www.packvol.com/tutorials.html
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User Interface

The working area of the application, besides the standard menu bar, tool bar, and
status bar, is divided in five parts:

A) the Visualization Area, on the right;

B) the Solver Panel and Messages Panel, up - left;

C) the Package and Container Panels, down - left;

D) the Report Text Controls, below the former;

E) the Auxiliary Toolbar panel, down - right.

packVol works with one document at a time, as any other single document applicat-
ion, but you can open a different document with no need to quit the application. The
program asks for closing and saving when there is a currently unsaved document.

For saving of data the program uses files with 3dp extension (the application icon is ).

During installation, the extension is added to the system registry, so that the files can

be opened by double clicking or via drag & drop. The Dynload and integrable versions

also support an xml interchange file.

Menu Bar

The various commands are organized in the menu sections File, Options, Settings,
Tools, Solution, Database, Report, View, Help.



packVol 3.8.6 - User Guide - 4

Menu File

Here you find the commands to open, save, import and print the document.

Command Description

New [Ctrl+N] Creates a new document by dropping all data and results.
Before performing the operation, the program asks to
save any modification.

Open [Ctrl+O] Opens an existing document.

Import (Excel) → → Master Data [Ctrl+Shift+M] imports the full load list
from an Excel file. See Import Master Data and Master
Data layout.
→ Import code/qty [Ctrl+Shift+Q] defines the load list
via code/quantity pairs, by selecting the package from the
internal database. See Import by code and Code/quantity
data layout.
→ Import stack matrix imports the stack matrix for the
current run. It should always be imported after the defin-
ition of the load list. See stack matrix data layout.

Export (Excel) Exports data on an Excel file.

Import (ODBC)
[Ctrl+Shift+Q]

Imports data from an ODBC data source. See the section
Import data via ODBC.

Export (ODBC)
[Ctrl+Shift+S]

Exports data to an ODBC data source. See the section
ODBC Export.

Import containers Imports the list of containers to be used in optimizat-
ion from an Excel file. See the section Container data
layout.

Export containers Exports the list of containers on Excel file. See the sect-
ion Container data layout.

Paste from
clipboard
[Ctrl+V]

Pastes data from the system clipboard to the current do-
cument. See the section Copy and paste via Clipboard
on how to format data.

Copy to
clipboard
[Ctrl+C]

Copies data of selected rows to the system clipboard, so
that they can be pasted into an external application. See
Copy and paste via Clipboard.

Save [Ctrl+S] Saves on file the current document.

Save as Saves the current document with a new name.

Save partial data → Save loaded packages saved the list of loaded packages
and containers used in the current solution.



packVol 3.8.6 - User Guide - 5

Command Description

→ Save unloaded packages
saves the list of packages that are not been loaded.
→ Save selected rows allows you to save on file only the
selected rows in data grids.

Print report
[Ctrl+P]

The entry becomes active when the Report is visualized
and allows to print it.

Print
preview

The entry becomes active when the Report is visualized
and allows to open the print preview manager.

Save report The entry becomes active at end of the optimization run
and allows saving the Report as an html document.

Open recent The program keeps a list of the most recently used files,
up to a maximum of nine entries. By clicking on a voice,
the corresponding file is opened.

Exit [Ctrl+Q] Quits the application.

Options Menu

Here you find the commands to change at any time the properties of the visualizat-
ion area. The default values can be set in the Options section of the Preferences
dialog.

Command Description

Black stage [Ctrl+B] Allows to choose the background color of the visualization
area between black, if selected, or white.

Info under mouse
[Ctrl+U]

Information on packages and containers are shown under
the mouse pointer. The function is left as an option bec-
ause it can produce slowdowns with outdated hardware
and can be ineffective in manual mode.

Enable item
highlight

When selected, the program highlights the row in the
Package Panel grids corresponding to the item currently
under the mouse pointer.

English pdf
load plan

When selected, the program creates the pdf Load plan
report in English (for non-English localization only).

Settings Menu

Here you can set the properties and behavior of the solver and open the Preferences
dialog.
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Command Description

Unusable
section

Opens the Unusable Section dialog window, where you
can define and/or delete an unusable section for that
container. The command is enabled when there is only
one container visualized on the main view (use the
Container drop-down menu or the contextual menu to
change selection).

Preferences Displays the Preferences Dialog. Settings are saved and
then loaded at start up.

Metric Units Displays the dialog where you set the Metric Units.

Disable loading
rules

The command opens a sub-menu where you can force the
program to disable some constraint even when these are
defined.
→Minimum Check disables the constraint on the minimum
number of packages to be loaded (parameter min).
→ Support surface disables check of the bearing surface
→ Stacking disables stacking indexes stk and stack matrix
elements regulating the vertical order.
→ Set / Batch load disables set load (parameter set) and
batch load (parameter bat).
→ Stacking weight disables the maximum bear weight
that a package can sustain (parameter mw).
→ Matching code disables the rule which ensures that
the package must be loaded only in a specific container
(parameter mc).
→ Maximum load disables the Maximum load assigned to
a container.

Cancel read-only
status

Data loaded from the database or imported from an Excel
file or via ODBC can be set as read-only to prevent accid-
ental modification of the input data. The option can be
set in the Configure Database dialog box. The command
removes the read-only status.

Improve solution This option only applies to the automatic calculation.
The program implements a statistical method when
searching for the best solutions. The option restarts the
calculation from the current solution. In case of complex
load plans you may obtain an improvement in terms of
volumetric occupancy.

Dynload version

Two-stage
settings

Opens the dialog to set configuration parameters for the
two-stage loading.
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Test settings are intended as options to check how the various constraints affect the

solution. At end of calculation or whenever a document is modified, all options are

automatically deselected. This choice has been made to avoid that, by forgetting the

test settings state, one obtains results which are apparently inconsistent.

Tools Menu

Here you find the most important commands which allow to execute the calculation
and to set the loading rules.

Command Description

Start evaluation
[Ctrl+R]

The command starts the calculation, automatic or
manual, depending on which of the two tabs Automatic
or Manual is active in the Solvers Panel.

Constraint
panel [Ctrl+D]

Opens the Constraint Panel. This auxiliary window
allows to define, in an intuitive mode, the allowed posit-
ions ps for a package, and to easily impose all constraints.

Set dialog Opens the Set Load dialog window. The dialog allows
you to define in visual mode which items need to enter a
set group, or to delete existing groups.

Stack matrix Opens the Stack matrix Panel, which shows in visual
mode all stacking rules and allows to set any exceptions
to the stacking rules.

Destination
dialog [Ctrl+Alt+D]

Opens the Destination Dialog, where you can define the
type of ordering for packages with assigned destination
index (parameter ds).

Container
optional data

Opens the container optional parameters dialog for the
current container. For the Standard/Lite version it is
activated only for Rack/Flat container type, while it is
always active for the Dynload version.

Solution Menu

The menu has various commands to modify the current solution.

Command Description

Start from
solution

By checking the voice before starting a run all packages
already loaded are kept in fixed position. See Modify
solution.

Modify solution Allows manual editing of the current solution. The entry
shows a sub-menu with two options
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Command Description

→ Keep fixed item qty [Ctrl+F] checks that the numbers
of packages don’t exceed the values in the qty cells of the
Dim. grid.
→ Don’t fix item qty [Ctrl+ALT+F] disables the previous
check.

Redistribute load In the case of an optimal multi-container solution, optim-
izes again the solution by placing the packages in the most
uniform possible way among the various containers.

Container selection The menu commands replicate those present on the
Output tab. The sub-commands allow you to perform
some operations on the containers selected in the Output
tab.
→ Save selected saves the load plan of the containers
entering the selection.
→ Re-optimize selected starts a new optimization of the
containers entering the selection.
→ Remove selected removes the selected containers,
updating the load list of the packages left on ground..

Merge solution Allows you to “merge” the current solution with another,
previously saved on file.

Remove unused
container(s)

Removes all empty containers.

Restore solution Undoes changes made to constraints or other parameters
of the current solution.

Delete solution Deletes the optimization solution while preserving all
input data.

Dynload version

Container selection → Empty selected acts like the Remove selected command
but does not delete the containers from the input list.

Convert The commands allow you to work with two-stage scheme.
The controls are activated / deactivated based on the cur-
rent state of the calculation
→ Convert to packages moves to the second stage, con-
verting the containers of the solution into packages and
loading, if defined, the working container.
→ Convert to containers converts a package into a
container by adapting the properties to the new object,
for example the weight becomes the tare weight.
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Dynload version

→ Save as pattern saves a single-reference solution in the
database for use with Dynload loading criteria.
→ Cancel conversion allows you to move back to the first
stage.

Multi stage
operations

The group of commands is activated after the conversion
to second stage.
→ Assign as first stage records the current solution as the
first stage.
→ Manage stages opens a dialog summarizing the recor-
ded stages.

Database Menu

Here you find the most important commands which allow to configure the internal
Database, to retrieve item definitions, and to manage the ODBC connection.

Command Description

Package manager → Data Retrieval displays the Package manager in retr-
ieval mode, used to transfer the package data stored in
the database onto the Package Panel.
→ DB maintenance displays the Package Manager in
maintenance mode, which allows you to insert, modify,
or delete the database records.

Save items
in database

Saves the rows selected in the Dim. grid into the datab-
ase. A row can be saved if you have defined the three
dimensions of the package and the code.

Container
manager

Displays the Container Manager, a dialog window listing
all containers saved into the database. Once opened, the
load plan view is substituted by a preview of the selected
container.

Configure
database

Opens the dialog window used to Configure the Datab-
ase.

Manage ODBC
connection

Duplicates the connection management dialog ODBC.
The command is always available, even in case the datab-
ase management is password protected.

Manage ODBC
load List

Opens a window that displays the load lists that can be
imported via ODBC. The window allows you to assign
their status. See the section ODBC Import for details.

Import / Update
database →

→ Data from ODBC, → Data from Excel → ... .
Allows you to rebuild the entire internal Database by
importing data from a data source or from Excel sheet.
See Import Database.
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Command Description

Export to
Excel file →

→ Package data, → Container data, → Stack matrix data.
Allows you to save the content of the internal database
in an Excel file.

Dynload version

Package manager → Pattern maintenance opens the Pattern manager
dialog.

Report Menu

Here you find the commands to create and visualize the reports. The tools for
creating documents are activated only at the end of the calculation.

Command Description

Pdf load plan → Manual Creation starts a work session where you can
manage the visualization of the load plan corresponding
to the solution. The work can be saved on file in pdf
format. See the section Create Load Plan.
→ Export load plan [Ctrl+E] allows you create the Load
plan report in pdf format for all containers entering the
solution. The command opens the Pdf Exporter dialog
box where you can set the print parameters and choose
the container range.

Measurements → View empty spaces allows you to view and measure
the unused spaces in the container. See View of Empty
Spaces for details.
→ View weight / density allows to check visually the
weight distribution of the current solution. See the sect-
ion Load Distribution.

Destination
list [Ctrl+Shift+D]

Opens the Destination Grid, showing the list of destinat-
ions ds. Using the grid, you can insert short notes about
the numerical indexes and choose the color for each dest-
ination.

View report Once selected, the load plan view is substituted by the
Report Window which shows a brief report about the
optimization results.

Dynload version

Report by external
volume

Calcola il volume di un contenitore tenendo conto delle
misure esterne.

View Menu

Here you find the commands used to change how the load plan is shown in the
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visualization area. The view can be rotated by dragging the mouse while holding
down the left button.

Command Description

Restore [F5] The view can be altered in many ways with the comm-
ands described in the following. The command restores
the initial view.

Zoom in [Up]
Zoom out [Down]

The view depth can be changed by acting with the mouse
wheel. The commands perform the same operations and
allow to use the Up/Down arrows as acceleration keys.

Quad view Switches from the standard axonometric view to the
quad-view. In the latter case the screen area is divided in
four viewports (axonometric, frontal, top, lateral view).
The mouse action is limited to the axonometric view (top-
left part).

Special rendering .. The item carries a sub-menu having two options, useful
in manual mode.
→ Wire frame visualizes the box edges only.
→ Transparent visualizes the box with transparency.

Hand tool When the command is activated, the mouse gesture
translates the container view.

Slider on
shrink boxes
[Ctrl+K]

When the command is active, the slider shrinks the
dimensions of the box edges while keeping unchanged the
position of the center-of-mass of the package.

View by
grouped blocks

In addition to the standard view by single package, the
program can display the load plan by groups of identical
packages. It is recommended to use this feature if the
number of boxes is large, say of the order of thousands
of items, or if you don’t have an accelerated 3D graphics
card.

Load sequence ... The item carries a sub-menu having three options, which
control the ordering of the load sequence.
→ Bottom-top sequence shows the sequence of packages
according to Bottom-Top order, starting from the bottom
of the container upwards;
→ Rear-front sequence shows the sequence of packages
according to Rear-Front order, starting from the rear of
the container towards the front;
→ Container default sequence defines the sequence accor-
ding to the value of the Pack: list box inside the Current
tab of the Container panel.

Special colors ... You can associate colors to some parameters.
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Command Description

→ By FI/LO order associates the package color to the dest-
ination ds;
→ By set groups associates the color to the set group set,
graying out those packages that do not enter a set;
→ By stack index associates the color to the stack index
stk, graying out those packages that do not have a defined
index.

Show “casting
spaces”

Shows/hides the spacing around the packages (param-
eters sp) in case these have been set.

Hide unusable
sections

Hides/shows the unusable sections in case these have been
set.

Full screen [F11] Turns on/off the program into full screen mode.

Hide Left Panels
[Ctrl+H]

Hides/shows all left panels as to maximize the visualizat-

ion area. The corresponding tool Expand is present
in the Auxiliary Toolbar.

Center of mass Activates the visualization of the center of mass, shown
as crosshair.

Dynload version

Show pallet
envelop

Shows the extent of a converted package using transpar-
ency.

The menu item Load Sequence ... and the option Pack: in the Current Container

panel are unrelated. You can choose the Bottom-top sequence in the Current panel and

then visualize the load plan according to the Rear-front slider sequence, or vice versa.

Help Menu

The commands allow to access the online help and to register the product.

Command Description

Help contents [F1] Displays this Guide in chm format.

Help on
constraint panel

Displays a message which reminds you that short des-
criptions of the fields in the Constraint grids can be
obtained by clicking on the column labels.

Register packVol ... Shows a dialog prompting for user and registration details
to validate the license of your copy of the program.

About packVol Displays a window showing information about the program:
version, copyright, registration.
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Command Description

Check for
updates

Opens a page at www.packvol.com via the default
browser to check for the presence of program updates.

Tool Bar
The most frequently used menu entries have an equivalent command in the tool bar

New Open

Save Start from Current

Start evaluation View summary report

Create load plan Export load plan

Measurements Preferences

Package manager - Retrieval Package manager - Maintenance

Save record Container manager

Configure database Constraint panel

Set load panel Stack matrix

Restore original view Quad view

Hand tool Block view

Slider on contract boxes Special colors

Full screen Help

Convert to packages [Dynload] Cancel conversion [Dynload]

Pattern manager [Dynload]

Status Bar
The status bar is divided in three parts: left, center, right.

Left: the pane carries information about the selected menu tool. During a manual
session it reports instead the item code of the selected package, and a short message
about the positioning of the box.

https://www.packvol.com
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Center: during a manual session, the pane reports basic information about the
selected package:

Box [L=92 W=81 H=55] @ [184 81 0] - pos: 04 - item ID: 1 cnt ID: 2

means, e.g., a box with ID 1 having length 92, width 81, and height 55 positioned
with orientation 04 at coordinates 184, 81, 0 of the second container. A small
progress bar appears when saving the pdf file of the load plan.

Right: the pane shows the complete path of the opened file.

Report Controls
The text fields show the values of the global
parameters of the optimization: number, volume,

weight of the packages and of the containers, in input and after the optimization.

Visualization area
The visualization area takes up most of
the program window area and usually
shows the load plan view. You can
visualize the load plan in axonometric or
orthographic (see figure) by pressing the

command View → Quad view . The
program employs many auxiliary win-
dows to perform specific tasks. When
opened, these windows temporarily hide
the visualization area or, in some cases,
occupy the whole application area.

To maximize the visualization area, the panel win-
dow on the left can be temporarily hidden by
using the command View → Hide Left Panel or

by pressing the corresponding tool found in the
Auxiliary Toolbar. The width of the left panel can
be changed by dragging the black bar that appears
by clicking on the edge separating the panel from
the Visualization Area.

Whenever you modify a constraint and/or the quantity of packages, the load view is

rendered with pastel colors to stress that the shown solution is no more in sync with the

panel data. By changing dimensions, both for packages and containers, or by changing

the type of container, the solution is erased. Input data are preserved.



packVol 3.8.6 - User Guide - 15

Using the 3D View

• the mouse wheel enlarges/narrows the load plan view. You can also use the

menu tool View → Zoom in/out or the keys Arrow Up/Arrow Down;

• the view can be rotated around the center of the ideal rectangle bounding the

containers by moving the mouse while holding the left button down;

• The view can also be translated with the same mouse gesture after checking the

command View → Hand tool ;

• the command View → Restore (key F5) cancels changes to the view and

restores the initial settings.

Context menu

Pressing the right mouse button on the visualization area activates a popup menu.
This menu shows the code of the package and the name of the container under the
mouse pointer, and has the following commands:

Command Description

Go to definition
[line n.]

Selects the row of the Data Panel corresponding to the
package under the mouse pointer.

Show container # If the solution contains more than one container, selects
the container under the mouse pointer. It acts exactly as
the Container List combo box.

Show all containers Undoes the previous action and shows all containers
entering the solutions.

Save load plan # Allows you to save a 3dp file with the data of the selected
container.

Add cnt # to select-
ion

Adds the container to the active selection of the Output
tab.

Reoptimize cnt # Starts redistribution of the load for the active container.

Delete cnt # Removes the container and its content from the solution.

Dynload version

Empty cnt # Empties the container by keeping it in the solution.

Save cnt # as
pattern

Save the load plan as pattern, checking that the solution
is single reference.
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Solver Panel

The Panel is formed by three
tabs, Automatic, Manual and
Messages. The first two allow
you to select the choose the

work method and the start-up parameters of the session. The Messages tab dis-
plays info on the performed operations.

Data Panel

Input / output data are man-
aged within the Data Panel.
The two Packages and Contain-
ers tools allow you to quickly
select the Package Panel, for
managing package data, or the

Container Panel, for managing container data. Above these buttons a label reminds
the metric units currently in use.

Dynload version When passing to the second

stage, the Primary tab is added to the Data Panel. The new tab carries the summary

list of the first stage data.

Auxiliary Toolbar

The auxiliary toolbar has various controls that can be active / inactive / hidden.

min Dim. The text box is active when you visualize the empty
spaces and allows you to set the minimum size of the
displayed objects.

Expand The tool allows you to hide/show the Panel on the left as
to maximize the workspace area.

Slider The slider allows you to change the view of the
load in two different ways, deformation mode and sequ-
ence mode.
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Show: The drop-down list lists all containers and allows you
select one of them. The same action can be obtained by
opening the contextual menu of the workspace area or by
using the Output Tab toolbar.

Option Description

sequence mode Action in the slider arrow shows/hides the sequence of
loaded packages or blocks of packages. Mode is active when
you select the tool View → Slider on Load Sequence (tool

depressed).

deformation mode Action in the slider arrow shrinks the dimensions of the
boxes while keeping their center fixed. Mode is active
when you select the tool View → Slider on shrink boxes (tool

pressed).

The command View → View by grouped Blocks toggles between the view by
blocks or by single package. The ordering of the sequence is set by choosing one of
the items in the menu entry View → Load Sequence ...

If the solution includes multiple containers and you set the sequence mode, the sli-

der is enabled only when you select a single container. Instead, it is always active in

deformation mode.
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Package Panel

The Package Panel reports in tabular form data and parameters of the packing list
and is activated by clicking on the Packages tab.

In the User Interface of the program the properties of an item are divided into
seven tabbed grids, easily accessible with mouse click. Temporarily the grids can be
replaced by those of the Destinations and the Distribution.

1) Dim., reports code, input quantity, and dimensions;

2) Desc., reports color and description of the items;

3) Box, reports weight and priority rules;

4) Pos., reports all positional constraints;

5) List, reports constraints applying on the current list;

6) Hand., reports settings for handling of the packages;

7) Space, reports settings for empty spaces and columnar ordering;

Data can be entered:

• by manual input, to perform tests or modify the packing list;

• by data retrieval from the internal database;

• by importing master data from Excel file;

• by importing from Excel file with code/qty option;

• from any external database with support for the ODBC protocol;

• by entering the item code in a cell;

• by pasting from the system clipboard.

The input values follow a specific encoding, whose knowledge is needed only if you plan

to import data from external sources. Whenever you type in a cell that refers to a con-

straint, the program automatically displays the Constraint Panel, which offers a complete

graphical environment to enforce intuitively all loading rules. After you make a change

on the Panel, the numerical value in the grid cell is immediately updated. Similarly, if

you input a numeric value in a cell, the Panel immediately reflects the change.
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Dim. Grid (Dimensions)

qty
number of packages

Number of packages of the item.

Zero quantities are allowed, and the cell is colored red. At the end of calculation, a cell

acquires yellow color when the item has been partially loaded.

l, w, h
dimensions

Length l, width w and height h of the item. The fields are
integer valued.

The unit measures are those defined in the Metric Units dialog window and are reported

on top of the grid for convenience.

code
package code

The code is an alphanumeric string. In the load list the
duplication of code is allowed.

If you enter the code of a record present in the internal database, the definitions of the

item are automatically retrieved (see Retrieval by code).

pk
loaded packages

After optimization reports the number of loaded packages.
Cells of the fields are always read-only.

The color of the cell is that defined in the c field of the Desc. grid. At the end of

calculation, by clicking on a cell pk all boxes of that item are hidden from the view. By

clicking a second time the group is shown again.

Dim. Grid Menu

Command Description

Add package(s) from datab-
ase

Opens the database window in retrieval mode.

Select all [Ctrl+A] Selects all rows.

Delete selected rows
Ctrl+X

Deletes selected rows from all panel grids.

Copy selected rows
Ctrl+C

Replicates the command present in the File menu.

Paste copied rows
Ctrl+V

Replicates the command present in the File menu.
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Command Description

Add rows to
database

Stores selected rows into the database. For
Standard / Lite version, if Enable load by objects
is enabled, the type, box or plt, is that of the row.

Show all type By clicking on a colored cell pk, all packages of
that type are hidden from the view. The comm-
and allows to restore the original view.

Hide all type The command hides all packages from the view.

Help about
the constraints

The command reminds to click on the grid labels to
get a description of the constraints.

Desc. Grid (Description)

code
identifier string

Identifier string, repeated from the Dim. grid and unchang-
eable.

descr.
description

Optional notes and descriptions, included in the load plan
report.

other
optional description

Optional description or numeric field.

The field is displayed when you enable the option Enable secondary description field
in the database configuration dialog.

c
package color

Color of the item.

Clicking on a cell opens the standard Color Dialog, which allows you to assign a color

to the item. The value 1 indicates a User defined color. The value 2 indicates that the

color has been assigned randomly.

Desc. Grid Menu

Command Description

Select all [Ctrl+A] Selects all rows.

Cancel User color Cancels the color chosen by the User for all selected
rows.
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Command Description

Set random color Chooses the package color randomly for all selected
rows.

Choose item color Allows you to assign a color to the item.

Show all type By clicking on a colored cell of the rightmost col-
umn, all packages of that type are hidden from the
view. The command allows to restore the original
view.

Hide all type Hides all packages from the view.

Box Grid (Single Box Constraints)

code
identifier string

Identifier string, repeated from the Dim. grid and unchang-
eable.

wt.
package weight

Weight of the package. Must be expressed in the same unit
of measure used in Current Tab of the Container Panel.

qt/b
number of objects

Number of “objects” forming the package.

Standard: the cell is visible if load by objects or field display is enabled in the Preferences

dialog. Always visible for Dynload.

bat
batch load

Packages are loaded in each container in multiples of the
bat number.

If the input quantity qty is not a multiple of bat, a dialog window helps you correct the

input. The zero or the empty value removes the constraint.

fml
family

For Dynload version only, patter name or rule of grouping
/ exclusion. Table of possible values.

set
set load

In each container, items with the same alphanumeric label
must be in a defined ratio.
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In set load, the connected items form a single logical unit with quantities in a defined

ratio. For example, [tables, chairs] in (1:4) ratio. The program calculates the ratio

automatically from the item with minimum quantity. For example, if you define a set

with elements A, B and C, with qty equal to 10, 20 and 40 respectively, the program

loads the packages A, B, C respecting the proportions 1:2:4. If the program cannot find

the ratio, the optimization is stopped.

Box Grid Menu

Command Description

Select all [Ctrl+A] Selects all rows.

Show all items By clicking on a colored cell on the rightmost col-
umn, all packages of that type are hidden from the
view. The command allows to restore the original
view.

Hide all items The command hides all packages from view.

Help about
the constraints

The command reminds to click on the grid labels to
get a description of the constraints.

Pos. (Position Constraints) Grid

code
identifier string

Identifier string, repeated from the Dim. grid and unchang-
eable.

ps
allowed positions

Values between 1 and 63 in which a given package can be
loaded. See the section Position Codes for a full description
of the numeric codes and for their use in the import proc-
ess.

Easy to remind values are: 1 (the package cannot be rotated), 3 (only the positions

corresponding to rotations about the vertical axis), 63 (all positions allowed).

fl
floor-only

The numerical value, between 1 and 63 defines the posit-
ions for which the constraint must be applied. The zero or
empty value removes the constraint.
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tp
top-only

The value, between 1 and 63, defines the positions for which
packages of different type, or of same type but with a differ-
ent orientation, cannot be placed on top of it. The zero or
the empty value removes the constraint.

When the rule is applied the whole space above the package is considered as unusable.

As a reminder, the upper part of the package is rendered in yellow.

nf
not at floor

The value, between 1 and 63, defines the positions for which
the package cannot stay at floor. The zero or empty value
removes the constraint.

The field forces the package to stay above others. It is possible to stow other packages

on top of an item marked as nf, if these have a stacking index strictly higher to stk.

xs
max stack
max height

The cell sums up the values of the parameters max stack
and max height as set in the Constraint Panel. If edited
sets max stack for all faces.

The cell reports the numeric value of stack max if this is defined for all positions, while

it reports the label “V” in the case of a mixed rule. The cell color is set to red if max
height is nonzero for some position.

Max height
165 

max stack 3

H = 35

H = 30

The stack max field, with a positive integer value,
can be enforced for packages with an assigned fl, nt,
or nf constraint. The stack max value can be defined
with respect to each support face and indicates how
many packages of the same type and with the same or-
ientation can be stacked one on top of the other. The
zero or empty value removes the constraint so that
the stack is limited by the height of the container.

max height indicates the maximum height at which a package can be placed. The
parameter can be set for each support face. The entry in the Constraint Panel is
disabled if the fl constraint is active, to avoid inconsistencies with max stack.

mw
maximum weight
supported

Maximum weight that the package can bear. The cell rep-
orts the numeric value of max weight if this is defined for
all positions, while it reports the label “V” in the case of
a mixed rule. If edited sets max weight for all faces. The
zero or the empty value removes the constraint.

Kg 80

mw 100

The program requires a value of weight but converts it internally
in the normal stress through division for the area of the supporting
surface. Hence, in a situation as depicted in figure, the object can-
not be positioned above because, although its weight is lower than
pm, it generates a stress higher than the maximum allowed. To

avoid positioning on the face you can impose a small non-zero value, for example
0.01.
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Pos. Grid Menu

Command Description

Select all [Ctrl+A] Selects all rows.

Allow all positions The package can be placed in any position (ps 63).

Only horizontal posit-
ions

Only the positions corresponding to rotations about the
vertical axis are allowed (ps 3).

Reference position only Only the position corresponding to the edges as defined
in the Dim. grid is allowed (ps 1).

Set allowed positions Opens a dialog where you can impose the ps position
parameter for all selected rows.

Set as floor only The package should be placed only on floor. The con-
straint is applied to all allowed positions (fl = ps).

Cancel as floor only Cancels the previous condition.

Set as top only Forces a package to sustain only packages of same type
and position. The constraint is applied to all allowed
positions (tp = ps).

Cancel as top only Cancels the previous condition.

Set as not at floor The package cannot be positioned at floor. The con-
straint is applied to all allowed positions (nf = ps).

Cancel as
not at floor

Cancels the previous condition.

Set common rules Opens a dialog where you can quickly set a common
value of max stack, max height and max bearing weight
mw for all selected rows.

Cancel all rules Cancels all applied rules, restoring the default values.

Show all items By clicking on a colored cell on the rightmost column,
all packages of that type are hidden from the view. The
command restores the original view.

Hide all items Hides all packages from the view.

Help about
the constraints

Reminds to click on the grid labels to get a description
of the constraints.
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List (List Constraints) Grid

code
identifier string

Identifier string, repeated from the Dim. grid and unchang-
eable.

ds
destinations
unloading order

Numerical identifier of longitudinal ordering along depth
(length axis). The value zero or empty cell disregards the
constraint.

min
minimum numbers
priority rule

The rule enforces a priority, as minimum numbers or prior-
ity index. It is applied in the case of solutions with fixed
number of containers,

The rules on how to apply the ds order and the meaning of the min parameter can be

set in the Destinations Dialog.

minimum number: in case you input a positive value, the solver tries to load at least
this number of packages for the given item. The constraint applies only in automatic
mode. The solver reports a warning whenever it’s not able to find a solution.

priority: the value is treated as a priority index. Packages with lowest index are
loaded first. The program does not impose any sort of spatial ordering.

mc
container
matching code

Assignment to container in the load list or, in Dynload vers-
ion, to primary container type. The zero value or the null
field removes the constraint.

Standard: the mc = n constraint forces a package to be loaded into the n container of

the list, with container numbering as reported in the container list .

Dynload: the type of primary container to be used in the calculation methods of the

first stage.

stk
stacking index

The rule enforces that no package with a lower stk value
can be placed on top of it. If edited sets the constraint for
all faces. The zero or empty value removes the constraint.

The cell reports the numeric value of stack as set in the Constraint Panel if this is

defined for all positions, while it reports the label “V” in the case of a mixed rule.

The stk and pm constraints impose vertical ordering and can compete. It is recommen-

ded not to use them at the same time.
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List Grid Menu

Command Description

Select all [Ctrl+A] Selects all rows.

Cancel destination ds Deletes destination indexes ds for the selected rows.

Cancel match code mc Deletes container indexes mc for the selected rows.

Cancel min number Deletes minimum numbers min for the selected rows.

Cancel stk index Deletes stack indexes stk for the selected rows.

Show all items By clicking on a colored cell on the rightmost column,
all packages of that type are hidden from the view. The
command allows to restore the original view.

Hide all items The command hides all packages from view.

Help about
the constraints

The command reminds to click on the grid labels to get
a description of the constraints.

Handl. Grid (Handling Constraints)

code
identifier string

Identifier string, repeated from the Dim. grid and unchang-
eable.

tpl Parameter for controlling the movement through forklift.
The zero or empty value removes the constraint. The cell
reports numerically the value of Control for forklift handling
defined in the Constraints Panel.

If you set tpl=1 the program checks that, when the package
is loaded with the long side aligned with the short side of the
container, there is enough space for the complete rotation of the
package. The constraint applies only to closed containers and is
disregarded for containers with overflow or rack/flat type. In this

way configurations are excluded which, although volumetrically more advantageous,
lead to the impossibility of loading. The program automatically sets the columnar
constraint “face to face”, useful when handling in blocks is foreseen. There are other
possible values as described in the following table.
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tpl=1 Sets the handling control via forklift in the case of “long
side of package” / “short side of container” side by side.
Automatically set the “face to face” columnar order.

tpl=2 Same as tpl=1, but leave columnar constraints unchanged.

tpl=3 Rotation check is performed with respect to both sides of the
package when aligned with the short side of the container.
Automatically set the “face to face” columnar order.

tpl=4 Same as tpl=3, but leave columnar constraints unchanged.

overh
max overhang

Percentage value (from 0 to 49) of overhang with respect
to the support base. The empty field, or the value -1, re-
assigns the default value of the container.

The program checks that the position of center of mass of each
package lies within the base (physical equilibrium). The default value
is taken from the text box Max box overhang (%) in the “Current”
tab of the Container panel. The field overh allows you to change the

default value of specific packages.

bdepth
max depth

Maximum depth of a box with respect to packages that
support it. The empty field, or the value -1, removes the
constraint.

This parameter is useful if the positioning of the upper box is
performed using forklifts.

clm
column order

The cell sums up the values of the parameters Columnar
order and All orientations when at the top as set in the Con-
straint Panel. The zero or the empty value removes the
constraint.

The numerical values, which can be combined, are:

clm=1 - “columnar order”
The package should stay within the base
provided by the lower package.
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clm=2 - “face on face”
The surfaces between lower and upper
packages must coincide.

clm=4 - “only on vertex”
A vertex of the package must coincide with
a vertex of the lower package.

clm=8 - “free at top”
Allows you to stow a package in any pos-
ition (ps=63) when it is placed on top of a
stack, regardless of the constraint currently
imposed.

The rules can be combined. For example, clm=5 (1+4) enforces the two constraints
clm=1 and clm=4 simultaneously.

Menu Handl. Grid

Command Description

Select all [Ctrl+A] Selects all rows.

Set columnar order Adds (deletes) the value clm=1 to the current value
of clm, always erasing clm=2.

Cancel columnar order Cancels the value clm=1 from the current value of
clm.

Set as only on vertex Adds (the value clm=4 to the current value of clm,
always erasing clm=2.

Cancel as only on vertex Cancels the value clm=4 from the current value of
clm.

Set as “face on face” Sets clm=2 as current value of clm.

Cancel “face on face” Cancels the value clm=2 from the current value of
clm.

Set “all positions when at
the top”

Adds the value clm=8 to the current value of clm.

Cancel “all positions when
at the top”

Cancels the value clm=8 from the current value of
clm.

Set parameters Opens a dialog where you can assign the value of
overh and max depth for all selected rows.

Cancel all rules Cancels all applied rules, restoring the default val-
ues.
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Command Description

Show all items By clicking on a colored cell on the rightmost col-
umn, all packages of that type are hidden from the
view. The command restores the original view.

Hide all items The command hides all packages from the view.

Help about
the constraints

The command reminds to click on the grid labels to
get a description of the constraints.

Space Grid (Spacing)

code
identifier string

Identifier string, repeated from the Dim. grid and unchang-
eable.

spL, spW, spH
padding space

Lateral empty spaces

Sometimes it is necessary to leave free space around a package (for example, due to
anchor hooks).

spL= spP= spH≥0 spP= spH≥0 

Container width

Le
ng

th

spL= spP= spH≥0 spP= spH=-1 

The parameters spL and spW specify the
amount of free space (“padding space”) in
the direction of the depth and width side,
respectively. The third parameter spH sp-
ecifies the orientation of the free spaces.

When spH ≥ 0 (or empty) the orientat-
ion refers to the package (“relative”, see
figure). A non-zero value of spH is used for
packages that can be fully rotated when
the top is placed sideways.

If spH=-1 (or otherwise negative), the or-
ientation instead refers to the container (“absolute”, see figure), regardless of the
position of the package.

Rsp, Fsp
spaces not allowed

Prevents placement of the package in rear (for a length Rsp)
or at the front (for a length Fsp) of the container.
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Space Grid Menu

Command Description

Select all [Ctrl+A] Selects all rows.

Set empty spaces Opens a dialog wherein you can set the spacing for all
selected rows.

Cancel empty spaces Cancels spL, spW, and spH parameters, for all selected
rows.

Set as absolute
spacing

Sets spH=-1, for all selected rows.

Cancel absolute
spacing

Cancels spH, for all selected rows.

Cancel all rules Cancels all applied rules, restoring the default values.

Show all items By clicking on a colored cell on the rightmost column,
all packages of that type are hidden from the view. The
command restores the original view.

Hide all items The command hides all packages from the view.

Help about
the constraints

The command reminds to click on the grid labels to get
a description of the constraints.

Destination Grid

The Destinations Grid has only descriptive fields and is used to assign a color of
your choice to the destination parameters, or to enter descriptions that are included
in the report, if required. The grid can be opened by pressing the menu command
Report → View Destination Grid [Ctrl+Shift+D].

ds numerical identifier of the desti-
nation

label description field

tot number of packages per destinat-
ion

pk number of loaded packages
per destination

c color, changeable by clicking on
the cell
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Destination Grid Menu

Command Description

Show all type By clicking on a pk cell, all packages with that dest-
ination are hidden from the view. The command
restores the original view.

Hide all type Hides all packages from the view.

Cancel User color Cancels the color chosen by the User.

Shared properties

The grids of the Package Panel share some common properties:

– the field code is repeated all over the tables;

– cells of the Dim. grid are always writable and are used to type in data manually.

Instead, cells of the other grids are initially read-only. A row of these grids bec-

omes writable when you input at least the box dimensions l, w, and h in the

corresponding row of the first grid;

– each table has initially twenty-four rows. New rows are automatically added by

the program when needed;

– each grid provides a contextual menu activated by right clicking on any cell,

which allows to perform actions on the selected items;

– to perform the selection, you can click and/or drag the mouse over the cells.

Hold the Ctrl key down to deselect a row from an existing selection. By pressing

the Shift key, it is possible to select a group of contiguous rows;

– when switching from a grid to another (e.g., from Dim. to Desc), selection is

preserved;

– apart for the Desc. grid, all cells of the rightmost column behave as visualization

buttons, allowing you to hide or show items from the load plan view.

Quick constraint settings

It is possible to impose the same value of the constraints with a suitable dialog,
specialized for each tab an opened with the contextual menu of the tab. Action
applies to all selected rows.

Set allowed positions
Opens a where you can impose the ps position parameter for
all selected rows in the Pos. grid.
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Set parameters
Allows you to assign the same value to the parameters for all
selected rows. The fields displayed depend on the selected
tab. If you want to reset to the default value, leave the field
blank and press OK.

Constraint Tips

As a help, you can obtain a synthetic description about the meaning of the con-
straints by clicking on each column’s tab.

Grid Status

When the option Settings → Start from current is active, all the columns except qty,
code, description, and qt/b, are set as read-only and not-editable. Cells are shown
with green to remember that the values are referring to the packages already loaded
and that their content cannot be changed.

The option Protect data loaded from Database or from Excel in the Configure Datab-
ase dialog box sets as read-only the previous columns for all records loaded from the
internal database, via ODBC or imported from an Excel file. This option is useful
to prevent accidental modification of the input data. Differently from the “Start
from current” case, the read-only status can be eliminated at any time with the
command Tools → Cancel read-only status.
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Containers

The Container Panel allows you to define the containers to be used and the rules

for their loading. To activate the panel, click on the Containers icon. Data are
organized in three panels accessed can be selected by clicking on the tabs.

1) Current Tab, shows data and parameters of the “active” container;

2) Input Tab, lists the types of containers to be used, and their number;

3) Output Tab, lists, in tabular form, information about the containers
employed in the optimization.

Current Panel
The Current Panel allows you to define
the dimensions of the container and to
set parameters for the positioning of the
load. If the solution has more than one
container, the panel becomes active once
it’s shown a single container. You can
select the active container via:

• the drop-down menu found in
the Auxiliary toolbar;

• the contextual menu of the
Visualization Area;

• clicking on the edit cell of the
Input Panel.

You can input the data manually, or you can retrieve the definitions from the internal
Database or from an Excel file.

Control Description

L, W, H
Internal
dimensions

The input fields (L) Length, (W) Width, and (H) Height refer to
the “internal” or to the “nominal” dimensions of the container.
Data are integer valued and must always be set.
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Pack:
Packing direct-
ion

The combo-box choices instruct the solver on how to stow the
packages.

Bottom-Top The program places the packages starting from the bot-

tom of the container, filling the base, and then goes

upward.

Rear-Front the program places the packages starting from the

rear of the container, filling as much as possible a

“slice” upward, and then continues to the front of the

container.

Layer-Front It’s a combination of the previous two: the positioning

follows the Rear-Front order, but the height of the load

is kept as low as possible, by maximizing the base as in

Bottom-Top ordering.

Type:
Type

The combo-box shows the possible type of containers.

Closed cnt This is the standard container, defined as any rectang-

ular envelop with fixed assigned sizes.

Open cnt The optimization is performed with respect to the height

of the container, which doesn’t have a fixed value and

is kept as small as possible. The load sequence is man-

aged by the application and the Pack: combo box is

disabled.

Rack/Flat This is a special container, open on one side and with

usable height greater than its actual physical size (see

figure). See properties.

For Open cnt the program keeps the height as small as possible but at the same time

tries to load the maximum number of the packages. The type is present for backwards

compatibility. It is recommended not to use it and to use the Rack/Flat type instead.

Max Load
max load

The text field Max Load, having decimal values, allows you
imposing the maximum load of the container.

Density
density

When Max Load is active, the rule ensures that the load distribut-
ion stays uniform throughout the length of the container. To en-
sure this, the application checks that in every possible “strip” of
length L, the weight W of the strip satisfies the relationship W/L
≤ weight/length where weight and length are the data entered in
dialog Load Distribution.
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Mean
mean density

In many situations, the density should be understood as an
average value to verify how much space must be occupied by heavy
packages resting on the ground. If the option is active, for each
package with weight w, the program evaluates the length l needed
to place the package in accordance with rule w/l = weight/length.
If l exceeds the base length of the package, other packages are
spaced appropriately.

Max overhang
Max box
overhang (%)

Defines the default value of max overhang when a package is st-
acked on another. The allowed value is expressed as percentage
of the edge dimension and varies from 0 to 49 (physical limit).
For any package, the default value can be changed by acting on
the cells overh of the Space grid.

Center of Mass
center of mass

The rule forces the solution to have the center of mass of the load
included in a target rectangle (see figure).

Forbid shift
no shift

To fulfill the requirement on the center of mass, the
program can shift the position of blocks of packages or even
of the entire load. The check box Forbid shift, if checked,
inhibits this functionality.

65% 35%

70%

28%

(0,0)

The target rectangle is defined by the four values DL (maximum
and minimum) and DW (maximum and minimum), expressed as
a percentage of the length and width of the container. No control
is operated in the vertical direction. If the option Forbid shift is

active, do not input too restrictive limits on the target rectangle, otherwise the
solver may not be able to find a solution.

Tool / Description

Save Save the container data in the internal database. Before saving,
a window allows you to enter the descriptive name of the
container. Leave the field blank if you want to cancel the op-
eration. In case of a duplicate name, a further dialog allows you
to resolve the collision by choosing among the options update
the record, save the container with a new name (the save window
is called up), cancel the operation.

Edit
profile

Opens the Load Profile dialog to assign a separate maximum
load for different sections of the container.

Additional
container
data

Opens the Additional data dialog to assign the parameters of
the rack/flat container type and, for the Dynload version only,
data needed to convert the container to a package.

Load Profile

The program allows you to assign a maximum load for different sections of the
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container, up to a maximum of five sections. Press the Edit Profile command.
In the dialog box choose the number of sections, and input the size and weight
assigned to each section. Whenever the data changes, the value of Max load is
recalculated automatically.

Additional data

The dialog allows you to assign param-
eters for the rack/flat container type
(all versions) and, for the Dynload vers-
ion, the “external” dimensions of the
container as well as the rules for its con-
version to package.

The data of the dialog are used in the
case of conversion of the container into
a package when using the two-stage
calculation scheme.

The primary / secondary options are
used to assign a descriptive flag to
simplify searching the container datab-

ase.

Control Description

Base heigh Lower external vertical dimension, the thickness of the base
for a pallet or the plinth for a crate. Rendered in dark red
graphically.

Height [H] When converting to package, the Fixed dimensions option
leaves the nominal height unchanged (box-type), while the
Load extension option takes as height of the package the
height of the load (pallet-type)
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Control Description

Upper external vertical dimension.

Length [L]
Width [W]

Meaning of the value entered in the text box: Add thickness
considers the value as external lateral dimension, Max over
length assumes the value as the maximum overhang with
respect to the dimensions of the base.

Value of overlength / thickness, applied symmetrically

Weight Container weight.

Control Description

Min vertical
overlap (%)

Applies to Rack / Flat containers and non-floor
packages only. Specifies the minimum percentage
of contact between the package and the physical
height of the wall. Packages higher than the height
of the wall are not loaded.

Allow over length
at any level
“inverse stair”

In containers with overlength, placement beyond
the base is allowed only for floor packages. If act-
ivated, the overhang is allowed at any height. In
this case one can obtain solutions as shown in the
figure.

Constraints for second stage

The grids replicate those of the Package manager and allow you to assign the con-
straints of the package obtained by conversion of the container.

Input Tab

The container Input tab reports the list of container types to be used, their number
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and the loading criterion. The tab differs between the Standard and Dynload vers-
ions and is absent in the Lite version. Except the first line, which is always defined

at start-up, all rows are entered by acting on the tool (Add) in the panel toolbar
or via the same tool in the main toolbar, by using the menu command Database →
Open Container Manager or by cloning a row. The tab has various groups of
controls:

Container list, List tools,

“Secondary” tools, Loading criterion tools.

Container list

The list reports the container types and has the following fields

Column Description

name container name. The field is editable and allows changing label.

qty number of containers.

used number of containers actually used (read-only).

(edit) allows you to switch to the Current tab of the container.

In the Standard and Lite version, entering qty=0 deletes the row, while in the Dynload

version the row is preserved.

List Tools

The panel carries a specialized toolbar which includes the following commands

Icon Command Description

Cancel Deselects any active line.

Add Opens the Container Manager to retrieve data.

Delete Deletes selected rows from the list.

Clean Deletes all the unused containers.

Edit Displays the Current panel for editing purposes.

Clone Duplicates the container row.
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Icon Command Description

Delete All Deletes the solution without altering the input data in
the Package Grids

Secondary tool

In the Dynload version the Assign tool
opens the Container Manager and allows
you to assign the container that will be

converted into the working container after the conversion to packages (“secondary
container”). The Undo tool deletes the association, while the Hide tool hides it from
the workspace. The assignment of the secondary container, other than to speed up
the conversion operations, allows to adapt the nominal dimensions of the containers
of the first stage.

Loading criterion tools

The panel shows the Solver: control (Dynload version) or a pair of controls (Standard
version) to define the loading criterion of the chosen containers.

The rules are the basis of the automatic calculation, and the action of the controls
is described in the Loading criteria section of the automatic calculation.

Output Tab
The Output Tab, not available in Lite
version, shows in tabular form the perc-
entages of load weight, used volume, and
number of loaded packages, thus provid-
ing a summary about the results achieved
in the optimization. Detailed informat-
ion can be obtained by opening the panel
Summary Report.

The panel also offers several tools that
allow you to manipulate the solution
without invalidating the results.

Toolbar

Icon Command Description

Clear Deselects all active rows.
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Icon Command Description

Save Saves the load plan of the containers entering the active
selection.

Re-optimize Starts a new optimization of the containers entering the
active selection.

Merge Allows you to “merge” the current solution with another
previously saved on file.

Remove Removes the selected containers, updating the load list
of the packages left on ground.

Show Displays the selected container.

To add/remove containers in the active selection, double click on the corresponding line,

or click on the box shown in the second column. You can also use the contextual menu

of the work area.

Unusable Spaces
The program allows you to define irregular containers with unusable volumes. In
this way, during the optimization, no package will be placed inside these regions.
Such spaces must have “rectangular” shape and are divided between “unusable
spaces” and “unusable sections”. Unusable spaces are considered as a property of
the irregular container. Unusable sections, instead, can be changed as desired in
the solution and are not saved into the Database. If present, unusable volumes are
shown in transparency.

Container with unusable spaces

You can define a container with unusable spaces in two ways:

By import
With the command File → Import container you can import an Excel file ap-
propriately formatted (see Import containers for details). If you need to save the
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definitions in the Database, select the Current Tab and click on the Save comm-
and.

By manual session
You can use a special manual session that allows you to visually locate the areas
to leave empty. First, enter the dimensions of the container in the Current tab of
the Container Panel. Then, enter in the Dim. grid the dimensions of the “blocks”
that form the unusable volumes. It is not necessary to specify their number and you
can leave blank the cells qty. Choose the tab Manual and check the option Define
a container with unusable spaces. Then, start the session as usual. A dialog message
reminds that the program will work in this specific mode. With the present setting
the program does not perform constraint checks, so that blocks can be placed in
arbitrary positions. At the end of the session a dialog allows entering the name
of the custom container which is then stored in the database. Leave the text field
blank to cancel the operation and disregard save of data.

Unusable Section

You can define unusable sections for each single
container. If your solution includes multiple contain-
ers, you must first select the container of interest via
the container drop down box.

the command Settings → Unusable Section opens a
dialog where you enter the extension of the unusable
section with the text boxes from – to.

You can also define an effective height of the container,
to prevent the placing of the packages near the “ceil-
ing” of the container. In this way is not necessary to
set the limit via the constraint maximum height.

The command OK assigns or modifies the section
(the program ensures that the entered values are dist-

inct). The command Delete eliminates the section. The command Close closes the
dialog without performing any operation.
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Package Constraints

packVol offers graphical environments for dealing with all loading rules in a simple
and intuitive way.

Constraint Panel allows you to impose rules for individual packages.

Destination Dialog allows you to enforce rules related to ordering of the
load plan.

Stack Panel
(with variants)

allows you to view the stacking rules between pairs
of packages and to apply exceptions, if required.

Set Load Dialog allows you to define which packages must be
grouped in case of set load.

Constraint Panel

The Constraints Panel is opened with the menu entry Tools → Open Constraint

Panel . The panel is also automatically displayed whenever you edit a cell of the
Box Grid, a cell of Space grid, a cell of Handl. Grid, or the cell stk of the List Grid.

Once opened, the load view is substituted by a view of all the six possible positions
of the package, shown with solid faces if the position is allowed, with wire-framed
edges if the position is forbidden. The package to be dealt with is selected by clicking
on the corresponding row of the Package Panel.

The positions are labeled according to the Encoding of Positions.

The Constraint Panel comes in two variants, the Panel Position, automatically
shown when you work with the Pos. and List tabs, and the Spacing Panel, shown
when you work with the Handl. or Space tab.
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In both panels, after any change is made, the numerical value in the grids is immediately

updated. Similarly, if you input a numeric value in the grids, the panel immediately

reflects the change.

Constraint Panel Tools

The Constraint Panel has a toolbar at the bottom with the following commands

Command Description

Back Selects the previous row of the package grids.

Next Selects the following row of the package grids.

Quick Opens the contextual menu of the active tab and operates only
on the selected package.

Stack Opens the Stack matrix dialog, where you can define “exc-
eptions” to stacking rules.

Close Closes the Panel.

Position constraints

By clicking on the proper controls, divided into six groups according to face and
orientation, you can impose all the constraints of the Box Grid and List Grid tabs.

Please pay attention to the fact that at least one position should be allowed. If you

try to deselect all the checkboxes, the first position is automatically checked. In case

of manual input or automatic import, the program can change the numerical values to

preserve the consistency of the data.
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The association between the controls of the panel and the cells of the grids is as
follows

ps Allow xs max stack, max height

fl floor-only mw max weight

tp top-only stk stack index

nf no floor.

as shown in the figure below

As a help to the User, the controls are disabled when their values are undefined. In
particular:

– if an edge dimension of the package is not defined or the item is read-only, all

groups are disabled;

– if a position is equivalent to a previous one, the whole group is disabled;

– if a position is forbidden, all controls of the group are disabled;

– the textbox for the max stack (xs) is enabled only if the package has been

marked as floor-only (fl), top-only (tp), or no-floor (nf);

– the constraint floor-only (fl) and no-floor (nf) are mutually exclusive, therefore

the program disables a check box if the other is checked;

– the max height textbox is disabled in case of floor-only position, to avoid

conflicts with the max stack value.

Spacing constraints

The Spacing Panel is automatically shown when you select Handl. or Space tab and
allows you to enter the parameters in an intuitive way.
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tpl Handling by fork-
lifts

The checkbox applies the rule of handling
by forklifts. The button change allows you
to assign the desired value for the param-
eter tpl. The positions subject to check are
shown with red color.

spL, spW, spH Free space around
package.

The three text boxes allow you to enter the
value of the empty space around packages.
The Abs choice allows you to distinguish
between “absolute” or “relative” spacing.

overh, max depth Max overhang/
Max depth

Allows you to enter the values of Max over-
hang and/or Max depth.

Rsp, Fsp Unavailable Spaces The two text boxes are used to enter the
values of the unavailable spaces Rsp and
Fsp.

clm Columnar order Applies the columnar ordering, combining
the values chosen in the proper checkboxes.

clm Special
position

Applies the constraint “free at top”, adding
the suitable value to the parameter clm.

The following figure shows, using colors, the association among cells of the grid and
controls of the panel.

As a help to the User, the controls are disabled when their values are undefined. In
particular:

– if you activate the check-box Abs (spacing relative to the container), the textbox

for the vertical dimension is disabled;

– if you impose Columnar order, the textbox Max item overhang is set on zero

and disabled;

– if you impose Set “face on face”, the textbox Max item overhang is set

on zero and disabled together with the options Columnar order and Only on
bottom vertex;
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– when you enable the option Forklift handling, the option Set “face on face”
is automatically activated, although it can be changed at later time.

Destination Dialog

The Destinations Dialog is used to enforce spatial and non-spatial ordering rules ins-
ide the containers. It consists of various groups of controls, some of which employ
the ds parameter set in the List grid, others are independent of it.

ds-min index as priority rule

ds - lowest indexes
should be loaded first

A package is loaded only after complete loading of all
packages with lower ds value.

min - lowest indexes
should be loaded first

A package is loaded only after complete loading of all
packages with lower min value.

Priority indexes are applied only in load criteria that do not require the addition of

containers. The min option allows you to reserve the index ds for spatial sorting, making

it possible to combine logical and geometric ordering.

ds-index as First In / Last Out order

For each individual
container

The packages are ordered in each container, but no rule
is set between the containers.

Keep order between
containers

The packages are ordered by considering the ordering
between consecutive containers.

No order inside
container

The option is shown when the previous option is
selected. When active, the order is maintained among
different containers, but not in each single container.
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ds-index as First In / Last Out order

Disable FI/LO order Disables temporarily the ordering ds without altering
the parameters. It’s mainly a test option.

DISABLED ORDER

   

RELATIVE ORDER ABSOLUTE ORDER

ds=1ds=2ds=3ds=4

packing direction

ABSOLUTE ORDER
(no “per-container” rules)

Max Mixing
When FI/LO is active, the program always checks that no packages
with lower ds indexes are “in front of” or “above” others with hig-
her indexes, but no check is performed in lateral direction. The
blocks of the same ds can therefore be arranged side by side and this
arrangement is not always acceptable. The Longitudinal mixing

group allows you to control the mixing.

Longitudinal mixing

Enable Max mixing The program tries, as far as possible and with the same
volumetric occupancy, to reduce the interpenetration of
blocks with different ds parameter.

max mixing Allows you to limit the extension of the overlap of
blocks of packages with different ds destinations within
a maximum value that must be entered in the text box
with the red background.

The empty field or a zero value for the max mixing text field result in a different behav-

ior. The empty field allows the application to minimize the overlap, while the zero value

completely prevents the mixing. In the latter case, one has a simple subdivision of the

container in independent longitudinal sections. If there are specific requirements, it is

recommended to keep this parameter field empty, as max mixing has a significant impact

on the volumetric efficiency.
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Loading / Unloading

Check loading / unload-
ing for each package

The function does not require the entering of ds values.
The program internally assigns a fictitious ds index to
each type, so that identical packages are always grouped
together, deciding the best sequence. The function is
useful in case you need to manage only one type at a
time.

Position / Equilibrium

Max depth The text box allows setting a predefined value for
the depth constraint common to all packages. In the
Handl.. tab you can change the value for specific items.

Rear balance check When applied the program checks that the back of the
package is resting against the wall of the container or
against another package.

The two options are competitive (Max depth tends to “bring forward”, while Rear

Balance tends to “bring backwards”). If Rear Balance is set, do not assign an overly

restrictive value to Max depth.

Stack Panel

It’s opened via the menu command To-

ols → Open Stack Matrix , and shows
the stack rules between pairs of packages
resulting from the setting of constraints
fl, tp, stk and xs..

Upon opening, two tree-controls allow
the selection of any pair of items on the
loading list (figure on the left). In area to
the right, the pairs are shown, with the
upper package colored green if the stack
is allowed, or red if the stack is prohib-

ited. The displayed combinations can be reduced by expanding the items of the
tree control and selecting the individual positions of the packages. The gray box
above each figure shows the state (green/red) and colored indicators of the applied
constraints. Click on the gray frame to display information on the stacking rule.

Stack Matrix

In addition to being an analysis tool, the panel allows you to define “exceptions” to
the default stacking constraints, namely, “to exclude stacking otherwise allowed” or
“to allow stacking otherwise excluded”.

The list of exceptions forms the Stack Matrix, and it is displayed by pressing the
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Active tool. Instead of the tree controls, a list appears that shows the imposed
exceptions. The first time it opens, the list is usually empty.

Exceptions can be imposed for each contact face. To exclude/accept a configuration,

simply double click with the mouse over the image, or, once you have selected a con-

figuration, use the commands of the work menu. If the command List item only is

selected, the tree-control does not show the positions. At the same time, two tools are

activated to allow / deny stacking for all positions. When an exception is activated, the

upper gray band becomes orange.

At the top of the panel, there is a tool menu with the following commands:

Command Description

Tools Opens the contextual menu.

Active Shows the Stack Matrix

Allow If List item only is active, allows stacking for all positions.

Deny If List item only is active, denies stacking for all positions.

Close Closes the dialog.

Work menu

The menu opens by right-clicking on the work area or by clicking on the To-

ols command.

Command Description

Deny this stacking Same action as double click.

Allow this stacking Same action as double click.

Set conjugate rule Assigns the same rule to the configuration
rotated by 90.

Deny shown stacking Excludes stacking between the two items (all
positions).

Allow shown stacking Allows stacking between the two items (all pos-
itions).

Clear shown exceptions Delete all exceptions for the shown packages.

Delete ALL exceptions Delete all exceptions. The action cannot be un-
done.
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Stack Matrix Dialog

The Stack Panel is displayed as a dialog window when called up by the command

Stack of the Constraint Panel;

Stack of the Package Manager.

The functions are identical to those described in the Stack Panel section.

In this display mode, the tree control on the left (bottom package) only lists the
selected package. The Tools menu features a filter that can be used to quickly select
the upper package. In the case of opening from the Database the dialog carries two
navigation buttons, and the exceptions apply to the stored records.

Set Load Dialog

The dialog is employed to enforce the Set
Load set constraint. You can open it by using
the command Tools → Open Group Dialog

, or by double-click on a cell set of the
List grid.

To form a group:

1) input the name in the text box New group
and press the button +;

2) select the items in the list to the right (hold the button Ctrl down for multiple
selections);

3) drag the selection on the name that appears in panel on the left.

To delete a group, or part of a group, use the contextual menu, opened by clicking
the right mouse button. The menu also holds commands to expand or collapse the
tree-list on the left. A button allows to choose the color for the group.

Error on Constraints

In case of inconsistency of the input list, the program stops the execution of the
optimization and displays an information window. Typical errors are:

– setting the center-of-mass control with types of package without assigned

weight;

– mc index higher than the number of containers;

– starting solution inconsistent with the set or bat constraints.

In the following cases, the dialog instead allows the User to take steps to solve the
problem.

Package Dimensions

The error window is activated when the dimensions of certain packages exceed the
dimensions of the containers. The dialog shows four self-explanatory options
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Set qty=0 for this item

Remove the item from
the input list

Leave the input list un-
changed

Stop the optimization
run

Batch Load

The dialog is used to correct the input data whenever the input quantity qty is
inconsistent with the batch parameter bat. You can select one of the following
intuitive options

Delete the packages in
excess from load plan

Treat remaining packages
as new batch

Keep remaining packages
as individual items

Cancel the optimization
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Solvers

packVol can operate in two distinct modes, automatic and manual. In automatic
mode the load plan is evaluated by the internal optimizer of the program, while
in manual mode the load plan is created or modified by the User, thanks to a 3D
graphical environment having the most common editing functions.

The choice is made by selecting the Automatic or Manual tab in Panel Solver before
starting the session. If the Message tab is selected, the program opens a window
where you can choose the desired mode.

Automatic Solver

To start the automatic optimization, select
the tab Automatic and then click on the
command Tool → Start Evaluation in the
menu bar . Once started the run,
a small window is displayed on top of
the main window, which carries a timer,
showing the elapsed time, and a button,
which allows you to stop the calculation.
This window also freezes any interact-
ion with the main application window.
During the evaluation, the Solver panel

is set on the Messages tab, which displays short messages about the optimization
status. The best solutions are visualized on the visualization area as soon as they
are found by the program.

Loading criteria

Load optimization can take place according to two somewhat conflicting schemes:

a) maximize the volumetric occupation of the loading list in a predetermined num-

ber of containers;

b) minimize the number (or capacity) of containers needed to load the entire loading

list.

packVol can apply both schemes with the controls of the Input tab of the Container
Panel. Loading normally occurs “sequentially”, one container at a time. In the case
of minimizing the number of containers, the last container in the loading list is used
for completion.

The program also has a “fast” mode in which all containers are processed simultan-
eously. The function is certainly useful as a method of estimation because it allows
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you to quickly obtain information on the number of containers needed. Sometimes
it is superior to the sequential method. The choice of the most suitable method is
left to the User tests, as the effectiveness is too dependent on the type of load plan.

The table lists the possible choices

label Standard (controls) Dynload (menu option)

sqn-f − Auto-Add container(s)
− Fast optimization

Sequential loading, fixed list

sqn-a + Auto-Add container(s)
− Fast optimization

Sequential loading, auto add

fst-f − Auto-Add container(s)
+ Fast optimization

Fast loading, fixed list

fst-a + Auto-Add container(s)
+ Fast optimization

Fast loading, auto add

The Lite version has only the method sqn-f for a single container.

Dynload criteria

The Dynload version offers additional loading criteria

label description menu option

mbin estimation of the type of container Sized multibin method

With the mbin criterion it is not necessary to enter a specific quantity in the
Container list but only a value greater than zero to take the type into account. The
application tries to estimate the best combination of types to minimize the capacity
of the containers needed to load the whole loading list.

The remaining criteria are intended for palletizing and take into account the “family”
fml parameter of the Box tab.

label description menu option

plt-r single reference with reuse of for-
med pallets

Mono article, reuse formed

plt-e single reference without reuse of
formed pallets

Mono article, without reuse

plt-s pallets with pairs of articles Threshold pairing article

With the plt-r and plt-e criteria the application optimizes each package in the input
list, “row by row” (or by groups of rows controlled by fml), looking for the best
possible saturation on the container types available in input. The solutions formed
in this first step have therefore defined items. The remaining packages are then
optimized in mixed loading. In the case plt-r, before starting the optimization in
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mixed loading, the program checks if the packages can be loaded in the nominal
volume of the containers formed. This step can improve the volumetric efficiency,
but it leads to mixing of the items. With the plt-e criterion the step is skipped, and
the containers formed in the initial step remain with the assigned items.

The plt-s criterion performs the palletization calculation for all possible pairs of
packages. It arises from a personalization and is currently considered as “exper-
imental”. It is not described here.

Family fml

The fml parameter of the Box tab has the following values

value description

0 or blank With the criteria plt-r and plt-e the row is optimized individually
(single-item pallet formation).

> 0 With the plt-r and plt-e criteria, the rows with the same value of
the fml parameter are optimized in the same container (multi-item
pallet formation)

-1 This value excludes the application of the plt-r, plt-e criteria and the
item is optimized only in mixed load.

-2 This value completely excludes the item from the calculation. The
function is useful in the two-stages scheme if it is necessary to mix
packages to be optimized with preformed packages to be left un-
changed. With this value, the lines acquire a light gray color to
highlight that they are not included in the calculation.

pattern If the field is validated with the name of a pattern the formation of
single-reference containers is performed by applying the palletizing
scheme. Pattern and item size must be consistent.

Run options

The automatic tab carries the following controls

Option Description

Max execution
time (s)

Maximum execution time in seconds. If the solution has more
than one container, or if the setting Auto-Add container(s) is act-
ive, the execution time refers to each container. The program
can alter the execution time if needed.

Random start The optimization begins from a random choice. This allows you
exploration of different possible solutions.

volume
weight

The program optimizes the volumetric occupation of the
container (default option), or the weight loaded in the container.
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Option Description

Stop
Continue
Improve for

The group of options defines the behavior in case the solver can
complete the load for a single container. Since the program also
tries to stow the load in the most compact way, it can be us-
eful to leave the program running even when it finds an optimal
solution.

Destinations
Advanced sett-
ings

Shows a schematic summary of the current settings entered in

the Destinations Dialog. The Edit tool replicates the Tools
→ Destination dialog [Ctrl+Alt+D] menu command.

Redistribute load

One of the possible ways in which the program can be used is to calculate the
number of containers needed to completely load the input list. Sometimes it may
happen that the last containers have much lower volumetric efficiencies than the
first containers. Using the same number of containers, it is often preferable to have
a homogeneous distribution of the load among the containers. The command Tools
→ Redistribute Load meets this need. If called up, the program redoes the calculat-
ion starting from the solution obtained and searching for the most homogeneous
distribution.

Re-optimize Solution

The Re-optimize cnt # command from the visualization area menu performs load
compaction. This function can be useful when optimizing by weight. The complete
saturation of the maximum weight often corresponds to low volumetric efficiency.
Re-optimizing makes it possible to easily explore different load configurations, letting
the User choose the most suitable one. The command Solution→ Container selection
→ Re-optimize selected, or the Reoptimize tool of the Output tab, performs the
same function but allows you to work on the containers selected in the Output tab
at the same time.

Manual Solver

In manual mode the load sequence is defined
by the User. To start the work session,
select the tab Manual in the Solver Panel
and then click on the command Tool →
Start Evaluation in the menu bar . The
panel, besides a brief note on the features
of the mode, has two check boxes which
should be checked, if necessary, before you
start.
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Run options

Option Description

Don’t fix package qty in
advance

Starts the session without assigning the number of
packages, which can then be placed at will.

Define a container with un-
usable spaces

Starts a session where you can define a container
with unusable spaces.

Work Environment

The work environment is formed by: (A) the tools panel, (B) the settings panel,
(C) the control point tools, (D) the tool to switch in drag mode, (E) the package
list. The visualization area acquires interactive capabilities in response to the mouse
input. The toolbox has the usual editing functions of a graphics application. Tools
have an associated shortcut which allows to operate directly from the keyboard.

packVol is an optimization program, not a computer graphics application and the op-

erations that you can perform may differ substantially. For example, paste of packages

takes place only for those objects that satisfy all constraints and can be repeated only

up to the complete loading of a selected item (unless Don’t fix package qty in advance

or Define a container with unusable spaces is active).

Insertion mode

The insertion mode is the default mode and allows you to insert / delete packages
from the loading plan.
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Positioning the package

Packages can be positioned only at points predetermined by the program, called
“control points”, displayed as small yellow cubes and generated by the program it-
self. The point in which to insert the package is chosen by clicking on it with the
mouse. After selection, the box is displayed with green color if the position is valid,
with red color if any rule is violated.

By acting on the Settings it is possible to control the formation of the control points
and the application or not of the load rules. The dimension of cubes can be changed

using the Zoom in and Zoom out .

Choosing a package

The package to be placed is selected by clicking on
the line displayed in the read-only list on the left.
The code of the selected type is shown on a line at
the top with a background of the same color as the
item and which also shows the number of packages
of this type still to be loaded. By clicking on a row,
the package positioned at the current control point is
shown in the visualization area with orientation the
first among those allowed.

Displaying columns

The package list can be displayed via the item code (std) or with
an alternative listing (alt) as set in the Advanced tab of the Preferences dialog.

Rotation

The package can be rotated using the tool Rotate [R] according to the current
Settings while preserving the control point.

Insertion

To load a package, press the tool Insert [SPACE]. After insertion, the package
is drawn with solid shape. At the same time the program generates new control
points. Whenever the package cannot be placed, the insertion button get disabled.
A short message displayed in the right pane of the status bar and in the view of the
load shows the reason that prevents the insertion.

After insertion of a package the program automatically tries to load a package of same

type of the last inserted. If these are all loaded, the program chooses the first not loaded

package according to the numbering of items in the list. The program also tries, whenever

possible, to place a package in a valid position, fulfilling all imposed constraints. In the

Advanced tab of the Preferences dialog, you can choose if the new package should be

placed at lowest possible level (layer packing), or on top of rear columns (wall packing),

or in a position as determined by the program itself.
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Selection

Selection, necessary for both editing and dragging operations, is made in two dist-

inct ways depending on whether the Select by region tool [B] is activated or not.
Selected packages acquire a light gray color.

Status Action

Inactive Selection is done object by object by clicking with the mouse. A
second click on a selected package deselects the object.

Active Selection is performed by “region”. By clicking on two different
packages, you select all objects belonging to the ideal rectangle
having these two as opposite vertexes. This functionality is parti-
cularly useful because it allows selection of objects when they are
not displayed, or only partially displayed.

The tool Select All [Ctrl+A]selects all packages. Press the tool twice to cancel a
selection or hit the background of the visualization area.

Edit

The editing operations Cut [Ctrl+X], Copy [Ctrl+C], and Paste [Ctrl+V]
are enabled after selecting packages, if the Hide selection setting has not been act-
ivated. The selected objects are displayed with light gray color. After a copy or cut
operation, all packages entering the selection are drawn with a yellow wire frame.

By clicking the tool Paste all packages are inserted, starting from the control
point, if they respect all the imposed constraints.

Settings

The group settings control the checks performed by the program and some graphics
settings.

Option Action

Disable all rules Neglects the checks of allowed positions and constraints,
except collision between packages and over the boundaries
of the container.

Keep ps rules If the previous choice is active, with this option the program
keeps checking of the allowed positions.

Hide selection Suppresses the wireframe displaying the packages that are
copied or cut. This functionality is useful when moving
groups of packages (“cut–and–paste”) because it immed-
iately shows the position where they are placed but may be
annoying if one is interested only in cut operation.
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Option Action

Block current view Disables rotation of the load view.

All side points Normally the program generates only one control point
per usable space. The option generates side points for all
individual packages.

All top points Normally the program generates only one control point
per usable space. The option generates top points for all
individual packages.

Custom points

If you have need to place a package in a particular location, not provided by program,
you can act in two ways:

• insert the coordinates of the control point L, W and

H in the spin controls and click on the tool New
point [N];

• activate the dragging mode.

Dragging mode

If only one container is displayed, you can

activate the Drag [D] tool. When pres-
sed, the view is placed on quad-view bec-
ause dragging is more effective on orth-
ographic views. Selected objects can be
moved by holding down the mouse and
dragging the selection. In drag mode the
constraints are not checked, except for
the overlap between objects and over the
boundaries of the container.

To restrict the working area to a single container, use the combo box in the Auxiliary

Toolbar or the contextual menu of the visualization area.

During the manual session you can add a new container to the solution at any time.

Open the Container Manager and select it among those registered in the database.

Snap function

While dragging, the selection acquires a yellow color if it can be positioned, red if
there is no space to contain it. In the latter case, when the mouse is released, the
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program tries to place the selection in the “closest” available free space (“snap”).
This function is useful for positioning packages quickly and precisely.

Table of available tools

Undo last operation
[Ctrl+Z]

Redo last operation
[Ctrl+Y]

Select all [Ctrl+A] Select by region [B]

Insert package [SPACE] Rotate package [R]

Copy selected packages
[Ctrl+C]

Paste selected packages
[Ctrl+V]

Cut selected packages
[Ctrl+X]

Close working session
[Ctrl+Q]

New point [N] Zoom in/out control points
[Ctrl+(+,-)]

Drag objects [D]

Start from current

packVol allows you to combine automatic and manual modes. One can, for example,

– load some packages manually and then request the positioning of the others aut-
omatically;

– edit in manual mode a solution obtained automatically to change the positioning
of some packages.

To modify a verified solution while keeping the position of the packages of the current

solution unchanged, use Solution → Start from current command.

Once the command is activated, the associated tool changes appearance to remind

you that the function is active ( , “recording”). Cells of the Package Panel bec-
ome read-only, except for the qty field of the Dim. tab and all descriptive fields,
which remain editable. The program forces to enter values for qty greater than or
equal to those currently reported. You can add containers or item rows without
affecting the status of the verified solution.
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The starting solution is recorded and kept until the command is deselected. All optim-

ization sessions, both automatic and manual, performed after activation will always start

from the solution registered at the beginning.

When deselecting the command , if the solution has changed, the program asks
whether to accept the new solution or not.

Modify solution

Manual editing is the most common operation and for this reason the interface has
the Solution → Modify solution command, which allows you to start manual editing
without worrying about activating registration. The command has the two options
Keep fixed item qty, which checks that the number of loaded packages does not exceed
that entered in the field qty, and Don’t fix item qty, which does not limit loading of
packages.
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Analysis Tools

In addition to tools used to create the load plan documentation, the Report menu
also has tools for analyzing the solution. The commands are activated at the end of
the calculation, automatic and manual.

Summary Report

The tool Report→ View report activates
a window which replaces the load plan view.
The new view displays a summary about es-
sential data of the optimization session. The
summary can be printed or saved in html
format for later use and/or integration with
other documents. To print or save use the
standard commands in the File menu. The
commands are active only when this win-
dow is open. An auxiliary toolbar allows to

perform the same operations.

The report is intended primarily for use on video. For saving optimization data see sect-

ion Data Export. In the Dynload version, the Package Panel is replaced by a sortable

grid, listing the distribution of packages among the containers of the solution.

The panel has a toolbar with the following additional functions:

Command Description

Expand Expands the view of the Report to full window

Print Prints the summary report

Preview Starts the standard Print preview dialog

Save Saves the summary report in html format

Close Closes the panel

Measurements

packVol offers two measuring tools that are activated, in case the solution entails
multiple containers, if just one container is properly displayed.

Load Distribution

To visualize the longitudinal weight distribution, select the menu command Tool →
Weight / Density . The visualization area shows a lateral view of the container.
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To define the section to be studied, hold the left mouse button on one of the two
red triangular indicators and move the mouse. The section is given by the volume
inside the two indicators. The program displays a summary on linear dimension,
volume, loaded weight, and density of the section.

View empty spaces

The tool Report → Measurements → View empty spaces allows you to visualize the
empty spaces. To display a space

• Move the mouse over the placeholders. Information is shown on top of screen.

• Double-click on a placeholder to freeze the view of an empty space.

• Double click again to restore selection mode

• Use the “min Dim.” text box to control the spaces to visualize.
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Database and Network

packVol stores data of packages and containers in an internal database and employs
the definitions to simplify data entry operations in the Package Panel and Container
Panel.

The application also allows the acquisition and storage of data from any external
database that supports ODBC protocol. The application has been tested on many
systems: Sqlite, Microsoft Access, MySql, Microsoft Sql Server, AS400/DB2, Oracle
g. Please refer to the section ODBC Data Exchange for details.

The internal Database is not needed for proper program operation, and its use is optional.

The application does not automatically store information on packages or containers of

the solution, but instead stores them in the internal Database only when requested by

User. The use of the ODBC support is also optional. This last function is not included

in the Lite version.

Internal Database

Data are physically stored in the file packVol.sqlx of the installation folder for Win-
dows 2000/XP (usually C:\Program Files\packVol), or in the application data fol-
der for Windows Vista/7/8/10/11 (usually C:\ProgramData). If the file is lost or
damaged, a fresh copy can be found in the sub-folder packRescue of the installat-
ion folder (usually C:\Program Files\packVol for Windows 2000/XP, C:\Program
Files(x86)\packVol for Windows Vista/7/8/10/11).

By default, the folder C:\ProgramData is hidden. To display it, change the folder

display settings or enter the address C:\ProgramData\packVol in the address bar of

Windows Explorer.

Data Insert

You can populate the packages Database by either “saving data” of the solution or
through an “automatic import”.

The database manager does not allow duplication of the field code (packages) and name

(containers). In case of manual saving, suitable dialogs help you resolve name collision.

During the automatic import, duplicated records are disregarded.

Data saving

The rows selected in the Packages Data Panel can be permanently stored in the
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database using the menu command Database → Save items in database , or the
equivalent Insert row(s) into database command of the Dim. grid contextual menu.

For the container use the tool Save in the Input Tab of the Container panel.

Database import

Package data can be imported massively by ODBC connection or from Excel files
using the Database → Import / Update Database commands.

The Excel layouts for packages and containers are identical to those used for imp-
orting master data and containers.

The ODBC tables used are pv sku, pv cnt and pv obs. In case of import, all rows
are processed, regardless of the value of the selection index g job.

In both cases, data that refer to number of objects or destinations are not used.

Before starting the operation, a dialog
box allows you to specify whether you
want to import (“delete and write”)
or update (“write or overwrite”). In
both cases the operation cannot be
undone. During the operation, the
program saves the current database in

the backup file packVol.sqlx.SAVE. In case you need to restore the old data, delete
the file packVol.sqlx and rename the backup file using that same name.

Retrieval
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To transfer the package definitions from the database into the Package Panel grids

you can use the menu command Database→ Package managers→ Data retrieval ,
or the context menu command Add package(s) from database of the Dim. grid.

Once opened, the Manager window takes the place of the load view and shows in
tabular form all database records. The records can be sorted by clicking on the field
labels, which reproduce that of the Package tabs. The volume field is displayed for
reference and for ordering purposes. The value is automatically evaluated by the
program.

To load the data, select the desired rows and click on the Load button, or use
the contextual menu as shown in the figure.

The window has an additional toolbar having the following tools:

Command Description

Load Appends the selected records to the package grids.

Clear Clears the current selection.

Type Displays a menu with which you can isolate records having a
stack matrix rule. If the “load by objects” is active, the menu
also allows to show only packages of type box and/or type plt.

Back Displays the previous records.

Next Displays the next records.

Filter Displays a menu where you can filter the records according to
code or to description. The input string should follow the usual
SQL syntax, with % as the wild card character.

Close Closes the window.

Two commands Next, Back allow you to browse the records. The database can easily
store thousands of records, but the manager limits the view to one hundred rows at
a time.

Retrieval by code

If you enter the code of a record present in
the internal database, as soon as the cursor
changes position, the definitions of the item are
automatically retrieved from the database and
transferred to the Package Panel. At this point

you need just to enter the number of packages. This function allows you to quickly
create the load list, without the need to open the Package Manager.
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Retrieval by pattern

For the Dynload version, if you enter the name
of a registered pattern in an fml cell, the
package data is automatically loaded, and the

associated container is added to the container list.

Container Manager

The Container Manager allows you to transfer the definitions stored in the database
to the Container Panel. The manager is opened with the command Database →
Container manager . The tool is replicated in the Input Tab of the Containers
Panel.

The manager does not have maintenance tools. All records are read-only. Data should

be inserted by means of the tool the Save Data, found in the Current tab.

The dialog shows all registered containers and lists name, dimensions, type and
whether it’s irregular. You can select a container by clicking on a row of the grid
list. When the dialog is active, the visualization area displays a preview of the
selected container. The manager has the following tools

Command Description

Cancel Deselects any active line.

Load Transfers the container data into the Current tab of the
Container Panel
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Command Description

Delete Deletes permanently the selected records.

Close Closes the dialog.

The Dynload version allows you to filter by primary and secondary containers.

Package maintenance

The maintenance interface is used to insert / modify / delete records of the datab-
ase and is activated with the menu command Database → Package managers → DB

maintenance .

The auxiliary toolbar on top of the list of records have essentially the same tools of
the Data Retrieval manager. Only difference:

the tool Delete takes the place of the tool Load and allows to delete the selected

records.

Below the record list a set of suitable input boxes allow insertion of a new record or
the update of an existing one. The following list shows association with the fields
of the Package Panel tabs.

• code, length, width, height: fields of Dim. Tab.

• desc [, other]: fields of Desc. Tab.

• weight, batch, set, qt/b: fields of Box Tab.

Some tools depend on the version:
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Tool Version Description

hbase standard pallet base, if > 0 and load by object is active, as-
sumes a type plt item

plt/mc dynload name of the associated container, the tool op-
ens the Container Manager for name selection.

To set the constraints of the List, Pos., Handl. and Space tabs, the Manager includes
a specialized version of Constraint Panel, and a grid

which reports the numerical value of the imposed constraints. Cells can be edited
as a shortcut option.

Above the group of textboxes there is a second toolbar with the following functions:

Command Description

Color Assigns the color of the package.

Space Shows the Spacing constraints Panel.

Stack Opens the Stack Matrix dialog. The dialog, besides all funct-
ions of the standard Stack Matrix dialog, has two other browsing
buttons for navigating through records on the database.

Insert Inserts a new item into the database.

Update updates data of a record. All the fields can be changed except
the code.

New Deletes all data entered in text boxes.
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Configure Database

The database can be configured with a dedicated dialog, that you open using the

command Tools → Configure database . The dialog is formed by four tabbed
windows, Authentication, General, ODBC, Local DB.

In the Windows Vista/7/8/10/11 operating systems, all operations marked with requ-

ire administrator privileges. To start the program as administrator, right-click on the

program icon and select the item Run as administrator.

Authentication

If you input and confirm a password ( ), the
access to the database maintenance window and
all operations involving changes to the data will
become password protected. When you start
the program the first time, authentication is
disabled. To enable it, enter the password in
the first box, confirm it in the second and press
the Set Password button ( ). If you activate
a password and you wish to return to the non-
authenticated mode, simply enter an empty pas-
sword and press confirm.

Protected operations are:

• management of the internal database, including insertion of new records
via the contextual menu of Dim. tab;

• updating of the internal Database of data import;

• update/insertion/deletion on container data;

• modification of the ODBC connection start configuration;

• creation of ODBC exchange tables;

• configuration of the generation of automatic reports when saving data;

• change of the read-only status of input data, if this option has been
enabled in the tab General described below.

To perform each of those operations, password
should be entered in the text field of a simple dialog.
Checking the box Remember my credentials for this
session, the password will no longer required for the
current work session. In case you need to restore
the password prompt, open again the tab Authenti-
cation and check the box Disable auto-authentication
and prompt for password again.
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General

The General Tab is used to:
- set the protection options against changes in the imp-
orted data;
- enable additional fields in the Package Panel.
To make the changes operational, click on Confirm bef-
ore closing the dialog or changing tab.

Protect data loaded from
Database, Excel or ODBC

The data of containers and packages can be modified at
any time by editing the input controls. When checked,
the option prevents modification of the imported data
imported from data sources. This feature is intended
to prevent accidental changes.

Force read-only status
for all users

The command sets the read-only status for all Users
accessing the program.

Require password to unset
read-only status

Read-only status can be eliminated at any time using
the command Settings→ Cancel read-only status. When
checked, the command can be executed only if User has
administrator privileges.

Enable secondary des-
cription field

Displays the optional description in the Description
Grid. The values are used only to format the reports.

The command Edit allows you to configure the properties of
the descriptive secondary field: format (textual, numeric or
listings) and labels, both for the current interface language
and for English reports. In the case of a numeric format the
total value of the field is reported in the reports generated by
the application.

For the Standard version there are two further fields

Enable “load by objects” Enables the load by objects functionality.

Show qt/b field in Box
grid

Displays the qt/b column as a purely descriptive field.
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ODBC

The tab allows you to configure the connection to any
external database that supports the ODBC protocol.
It consists of three control groups, for the connection,
for the connection start options and for the creation
of exchange tables and saving options. This single
window can also be opened with the menu comm-
and Database → Manage ODBC Connection, which is
always available, even in case password protection is
enabled.

Datasource In the text box you enter the name of the Data Source
(DSN).

Username In the text box you enter the username for connecting,
if necessary.

Password In the text box you enter the username for connecting,
if necessary.

Connect Establishes the connection to the Data Source. If the
operation is successful, the button shows the label Dis-
connect and can be used to disconnect from the data
source.

Set as default
data source

Allows to register the DSN as the default and to fill
the text boxes with the data required for connection at
start-up.

Connect at program
start up

Establishes the connection to the data source at start-
up, without need for further intervention by the User.

Create The button is used to create the exchange tables. See
the section ODBC Tables for details. The operation
should be done the first time only. The action leads to
the deletion of the tables if they are already present.

Open Opens the dialog where you can set up the reports creat-
ion when the ODBC data is exported. The configurat-
ion is described in the section ODBC Export.
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Local DB

The fourth panel allows you to operate backup cop-
ies of the local database and to force the loading of
a Database from a location other than the predefined
one. This second operation, as described in the sect-
ion Sharing the Database, allows the sharing of a local
LAN network among users.

Copy DB Allows you to copy the database currently in use, if available,
in a different folder.

Assign Allows you to assign the database to be used in the current
session and all next openings of the program.

Clear Removes the association for the recorded database and restores
loading the database of the original installation.

REGISTERED
Database

The text reports the registered database for loading at the start
or the message No database registered in case of loading of the
predefined database. If the registered database is not accessible,
the message [ERROR] will appear.

WORKING
Database

The text reports the address of the currently loaded database
or the message No database loaded in case of error during the
loading.

Error Management

If for any reason the database is no more accessible, the program displays a dialog
allowing you correct the problem. You can undertake the following actions:

– Connect to a different work database, opens the
Local DB tab to register a different database;

– Use the database of the local installation, temp-

orarily removes the registered association;

– Continue without database support.

The first two options may require administrator privileges to be accepted. The last
option does not require password.
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Sharing the database

packVol can be installed on a local folder of a client PC but can be configured to
use a network shared database. We consider the case where you have installed the
program on various LAN connected PCs.

To share the database, follow these steps:

1) Run the program from any PC and open the Configure Database dialog
(Database→ Configure database→ Local DB). Press the button Copy and
copy the database on a shared folder at your choice. A standard dialog
will help you find the folder or to create a new folder. The folder must
have read and write permissions.

2) Click on the button Assign, find the previous shared folder and select the
file packVol.sqlx.

3) Repeat the previous step 2) from all other installations.

ODBC Data Exchange

The program can retrieve package and container data from any external database
with support for the ODBC protocol. As an example of how to set up the feature
we consider the case Microsoft Access. After creating a blank database, open the
ODBC Data Sources control panel (Start → Administrative Tools → Data Sources
(ODBC)). Press the button Add and click MS Access Driver. Enter a name for the
DSN, say pvDATA, and select the file you have just created.

On Windows Vista/7/8/10 64-bit /11, to properly register the data origin, it may be

necessary to open the 32-bit DSN management program.

Once packVol has started, open the configuration dialog using the command To-

ols → Configure Database , choose the Configure ODBC tab and establish the
connection.

After the connection is established, click on Create to create the exchange tables. At
this point you can populate the Access Database following the format of the tables.
Populate the table pv job, assigning a positive progressive value to the ID primary
key and setting g status equal to zero

In the installation folder you find a MS Access database called pvDLL.mdb that can be

used for testing purposes. The database contains data of a real example that can thus

be taken as reference.

Jobs List

The application uses the table pv job as a list of possible load plans (or “jobs”) to
be optimized. In this way, the program can be used concurrently by different users
or workstations. Through the menu command Database → Manage ODBC Import, a
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dialog window opens that displays the list of jobs registered in the external Database,
with fields that faithfully reproduce those contained in the table pv job.

The rows are colored according to the following Color key

status color description

assigned green job already imported yet to be optimized.

imported orange job currently imported.

completed red job set in the completed state (automatically set in case
of export).

available white job never imported.

The Operations button (or the contextual menu) allows you to

1) mark a job as completed even without the export;

2) restore the previous state (from completed to assigned or from assigned to

available);

In case the file is saved, the information on data source of the imported job is pres-

erved. You can mark a job as completed only if said job is currently loaded (in other

words, only an “orange” row can be marked as “red”). Data can be loaded through

ODBC or through the opening of a file that was previously saved. The program does

not check whether the optimization has been performed and/or if the pdf report has

been generated.

Share on LAN

Remote Desktop

The program has been tested for use by Remote Desktop and with Terminal Server
services. It has also been verified to work properly in Linux and Mac OS X with
WINE emulator and with CodeWarrior.
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Sharing the Program

In this note we assume the program packVol has been installed in the folder
C:\Test\packVol with computer name \\NAMESERVER.

The default installation folders are

C:\Programs\packVol (Windows 2000/XP/Vista/7/8/10 32-bit),

C:\Program Files(x86)\packVol (Windows Vista/7/8/10 64-bit /11).

To share the program, follow these steps:

1) Share the installation folder C:\Test\packVol on the SERVER, say with
name packVol. Do not alter any permission.

2) Share the data folder C:\ProgramData\packVol on the SERVER, say with
name packVoData, or create a folder for sharing the database. Make sure
that Users have read and write permissions on the shared folder, oth-
erwise the program will generate errors on all database operations which
require write privileges.

3) From the CLIENT PC, open Explorer clicking on “My Network Places”
and find the shared folder (in the address bar should appear the address
\\NAMESERVER\packVol). Open the folder, right-click on the execut-
able packVol.exe and click “Send to Desktop (create shortcut)”.

4) Run packVol by double-clicking on the newly created shortcut. In case
you get the error message Database not found, choose the option Connect
to a different work database and skip to point 6).

5) Once the program is running, open the Configure Database dialog (Tools
→ Configure Database → Local DB).

6) Click on the button Assign and find the data folder packVolData on the
SERVER. Select the file packVol.sqlx and press OK.

If you open the database, (Tools → Open Package Manager → Data Retrieval), the
Database: label will report the path \NAMESERVER\packVolData\packVol.sqlx.
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Data Import

Import Data from Excel

packVol offers a complete set of functions for importing data via Excel in native file
format xls (Excel 97/2000/XP) or xlsx (Excel 2007/2010). Import commands can
be found in the menu File.

When you use import commands, prior
the opening of the Excel file an auxil-
iary window allows you to quickly check
the correctness of the data to be imp-
orted. The step can be skipped by
setting the option Don’t show row prev-
iew on Excel (ODBC) import in the

Preferences Dialog.

Import master data

The command File → Import (Excel) → Import Master Data [Ctrl+Shift+M] imports
in the data tabs the full definitions of the package types. The import layout is fixed.

In order not to have to distinguish between input and output Excel files, the program

acquires data only from the first sheet of the Excel file. Next sheets are ignored.

The installation does not provide sample files as creating a template is a straightforward

process. Open the program, Click on File → Export (Excel). A file is created with

complete headers that can be used to create the file to be imported.

If the file is generated by the export of the database, the AK - BI columns have additional

data. These fields are not intended for editing.

Import by code

The command File → Import (Excel) → Import by code [Ctrl+Shift+Q] allows you to
create the load list with minimum effort from the data stored in the database. In
Excel file you can define only two columns: the first (A) with the package code as
stored in the database, the second (B) with the number of packages. Optionally,
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you can also set the values that are not stored in the internal Database. See import
layout for formatting file data.

While reading the file, the program selects in the Database the record with the code
assigned in column A. If the record exists, the program retrieves the data and sets
the quantity as assigned in column B.

Import containers

The command File→ Import container allows to import the list of containers. In the
Excel file format, you can define both the dimensions of the container, and of the
possible unusable spaces.

Import via ODBC

To use the function, a data origin should be registered,
configured and populated as described in the section
ODBC Data Exchange. To import, click on the menu
command File → Import (ODBC) [Ctrl+Shift+O] and
select the desired job in the Jobs list dialog window.
This dialogue is the same as the one described in the

Jobs List section, but with disabled management functions.

Copy and paste via Clipboard

You can “Copy to” / “Paste from” the Clipboard all row data of the Package Panel.

To copy data from the program and paste it into an external application

1) in any of the Data Panel grids, select the lines you need to copy;

2) click on File → Copy to clipboard [Ctrl+C] or select the Dim. grid and use

the contextual menu;

3) paste in the external application (usually with the key combination [Ctrl+V])

To copy data from an external application and paste it into the program

1) in the external application format the file using the tab character (Tab key) as

data separator, using the same data sequence as reported in the Excel master

data or code/quantity format;
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2) in the external program, copy the data (usually with the combination [Ctrl+C]);

3) from packVol click on File → Paste from clipboard [Ctrl+V] or use the

contextual menu if the Dim. tab is active.

The program automatically loads the data based
on the number of columns and the layout of
pasted data. If the application is not able
to interpret the input, a dialog is shown for
choosing the type of import. Inconsistent lines
are ignored.
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Standard/Lite features

Load by objects

“Load by objects” is a form of implicit palletizing used by the Standard and Lite
versions and is activated by checking the Enable “load by objects” checkbox in the

– General tab of the database configuration dialog, Standard version;

– Data Options section of the Preferences dialog, Lite version.

When the function is activated the Box tab shows the additional field qt/b which
shows the number of objects that make up the package and, optionally, the num-
ber of objects per layer. In fact, the program provides the possibility that each
package can be filled with objects, of unspecified shape, in a maximum number per
package equal to the value entered for qt/b and to force the creation of the number
of packages by modular division between the quantity of incoming items and the
number of items per package.

The format of the qt/b field is <number per layer|>number of objects, for example

qt/b=4|12, qt/b=16. The default is qt/b=1 which disables the function.

The records with qt/b ̸=1 are then divided into records of type box (default) and plt
and an additional parameter hbase can be associated with the latter. The distinction
is applied in the creation of packages and must be imposed according to the data
entry procedure.

Database
In the Package manager the type is chosen from the drop-down
menu, validating the qt/b field and, if necessary, the hbase field.

Excel Import
The F (qt/b) and AD columns should be used. If the AD field is empty and the F
field does not carry any layer information the type is box, otherwise the type is plt
and the AD value is associated with hbase

ODBC Import
The g qtb and g btype fields must be used with the same rules seen for Excel import.

On import, the number of packages is deducted by division. The following example
illustrates the logic applied to the incoming data

qty code dimensions weight qt/b (type) hbase

14 BOX 120 x 80 x 180 240.00 8 box

18 PLT 120 x 80 x 180 240.00 4|12 plt 15

Two lines are created for the BOX package, with the same dimensions and different
weight, and two lines for the PLT package, different in weight and height

qty code dimensions weight qt/b

1 BOX 120 x 80 x 180 240.00 8
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qty code dimensions weight qt/b

1 BOX 120 x 80 x 180 180.00 6

1 PLT 120 x 80 x 195 240.00 4|12
1 PLT 120 x 80 x 75 80.00 4|4

When the package definitions are transferred from the internal database, either through

the Package Manager or by entering the code, the data is passed to a mask in which

you enter the number of objects to be loaded, so that the program can proceed with

the formation of the list of packages. After the load list has been created, the qt/b
parameter remains purely descriptive and is no longer used.

Dynload version features

Two-stage loading

The Dynload version can convert the contain-
ers of the solution, obtained both manually
and automatically, into actual packages to
be optimized in additional containers. This
feature responds to a commonly used scheme,
which requires a “first stage” where the
packages are loaded into containers (“prim-
ary” in the program terminology, for example
boxes on pallets), and a subsequent “second
stage” in which these are further loaded into
larger containers (“secondary” in the term-

inology of the program, for example pallets on trucks).

The conversion is done with the Solution→ Convert→ Convert to package command

or with the associated tool . After the conversion, the Primary tab is activated,
and the display of the converted packages is maintained. Packages left on the ground
or excluded from the calculation are not displayed.

The two commands are changed to Solution → Convert → Cancel conversion ( )
and allow you to return to the first stage.

If you cancel the conversion after running the second optimization step, the solution is

lost. Upon rollback, the program asks to save the solution and proposes a new name to

save the data that would be otherwise lost.

Patterns

The program allows you to maintain a single reference solution as a palletization
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scheme (“pattern”) and to use information about geometry and quantity during aut-
omatic optimization. Normally the pattern is built in manual session, reproducing a
known scheme, for example that of an automatic palletizer.

To save a pattern, you can use the contextual menu of the visualization area by
pressing the Save cnt # as pattern item or the menu command Solution → Convert
→ Save as pattern. In the latter case, the conversion takes place for the containers
selected in the Output tab. If there is no selection, the current container is converted,
if any, otherwise the conversion is performed for all single-reference containers enter-
ing the solution.

In the dialog box that appears, enter the name of the pattern and, optionally, the
minimum number of objects to consider the schema valid. If the pattern name
already exists, a dialog allows you to resolve the collision.

Pattern manager

The Pattern manager reports the list of registered models, indicating name, assoc-
iated container, object size, number of objects in the schema, minimum number of
objects to keep the schema valid, pattern type (always “3D”).

To open the Pattern manager, use the command Database → Package manager →
Pattern maintenance . Once a model is selected, the view of the load is replaced
by a preview of the palletizing scheme. In addition to the usual navigation and
filtering tools, the manager has the following tools

Command Description

Cancel Deselects any active line.

Export Exports selected patterns, or all patterns if no lines are selected,
to xml file.
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Command Description

Rename Allows you to change the name of the pattern, which must be
entered in the sided text box.

Edit Imports the pattern as a solution for a possible modification.

Delete Deletes the pattern(s) from the database.

Load Transfers pattern data to the Data Panel, updating the
Packages and Containers tabs accordingly.

Close Closes the dialog box.

The dialog optionally allows you to define the rules for loading the object of the
pattern when it is not palletized. To assign them, after having edited the two

constraint grids, which replicate those of the Package manager, press the tool .

The ability to assign rules is present because a pattern is independent and is not
associated with any package registered in the database. In the absence of an item
code, this happens for example with the command Load, the program has no way
of associating rules for the constraints. On the other hand, when the pattern is as-
sociated with an existing package in the database, this happens for example during
import where you can set both the item code and the pattern, the rules of the
registered package take precedence over those of the pattern.

Two-stage load settings

The dialog, in addition to a self-explanatory error handling section for incorrect or
missing patterns, allows, with the option “.. set the height ..”, to adapt the height of
the primary container to the height of the secondary container in which the object
will be placed. The option can be applied if secondary container has been defined
in the Current tab.
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Reports and Saving data

Saving on File

The work session can be saved at any time in a file, with extension 3dp using the

File → Save and File → Save as commands. In addition to these two standard
commands, the program offers the possibility to save partial with the command File
→ Save partial data and Solution→ Container selection→ Save selected. The Dynload
and integrable versions also support an xml interchange file.

Save Summary Report

The Summary report (see section) is intended primarily for on-screen use. It can
nevertheless be saved in the html format, using the command File → Save summary.

Load plan in PDF format

packVol generates documentation on the load plan in pdf format, with automatic
procedures, started by the User or by the program itself, or with a manual proced-
ure. The commands are found in the menu Report → Load plan in pdf format and
are enabled for optimized solutions only.

Some formatting options are present on the Report of the Preference dialog, as they are

fixed once.

Please note that if the file that you want to save is in use by another program, such as

Adobe Reader, saving the file may fail. When creating the pdf file, a dialog freezes any

input. The operation cannot be interrupted.

Document formatting

There are many ways to format documentation; the main formatting parameters
are shown below.

List Options

Summary list When selected, in addition to the load list for each
container, the program generates a summary list with the
distribution of packages between the various containers of
the solution.

Unique code The program allows the code to be duplicated in the load
list. The option forces the program to group together types
with identical code into a single actual type, recalculating
the totals in the output list.
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Layout

The Layout sets the type and number of views to be generated. The layouts are
divided into dynamics, with a variable number of views, and statics, with a fixed
number of views. For dynamic layouts, the number of views is controlled in the set
of options Load instructions/Number of views.

single view [dynamic]

A sequence of views of the position is dis-

played from a single angle. The figure

shows the option “Print loading instruct-
ions”.

duo view [dynamic]

The same sequence of views of the single

layout is shown from two opposite angles.

The figure shows the document with the

option “view by sections”.

quad view [dynamic]

The same sequence of views of the single

layout is shown from four opposite angles.

The figure shows the print option without

positioning instructions.

planar layout [static]

A single view from above is generated,

with progressive numbering of the stacked

packages. The layout shows the summary

view and the load distribution.

simple layout [static]

Two summary views are generated from op-

posite angles. General information and load

list, if possible, are concentrated on a single

page.

level layout [static]

Displays a sequence of views from above

formed by horizontal sections. Stacked

identical packages are grouped in columns.
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layer layout [static] Like the previous one, but each layer cons-

ists of a single package. Identical stacked

items are not grouped.

The group displays also other drawing options

drawing style

color and text The package is rendered with color and displays item code.

text only The package is rendered with color but does not display item
code.

color only The package displays item code but is rendered in gray.

blank style The package is rendered in gray and does not display item code.

Single box label For drawing clarity, the code is associated, where possible, with
blocks of identical packages. This option forces displaying of
the code on every package.

Plan on new page If the option is selected, the sequence of views begins on a new
page, otherwise begins immediately after the load list.

Loading Instructions / Number of Views

The group is active only for dynamic layouts and allows you to control the number of
views and their presentation. The most important option is Simple view by sections
of the load. When the option is checked, the group displays only two active controls

Simple view by sections of the
load [active]

The views are drawn by splitting the load in
longitudinal sections.

Nr of view sections Here you enter the number of sections, from
one (equivalent to the simple layout) up to a
maximum number determined by the program.

When Simple view by sections of the load is inactive, the views are created by dis-
playing a sequence of blocks of identical packages, to have an effective description of
the load positioning sequence. In this case, the group of controls provide a greater
number of options.
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Nr of steps per
view

Number of blocks to be included in the same view. Varies from
one to four.

block size The combo box is used to set the size of the blocks. Options
are small, medium and large.

Print loading in-
structions

If selected, for each block the document reports a summary of
weight and volume of the block, orientation of the package, pos-
ition and extent of the block.

block size is a useful parameter only when the load plan is formed by a small number

of different items but a large number of packages. In this case, it may happen that the

load plan is formed by a small number of large blocks. The user can choose whether

to display them in full, or whether to use the view for small blocks to respect the load

positioning sequence.

Sequence order

The group is enabled only for dynamic layouts and makes it possible to choose the
order of the views, regardless of the option selected during the optimization.

Sequence description

Container default sequence The views are shown according to the current choice
of the Load combo-box.

Rear-Front sequence The views are shown according to the rear-front
sequence.

Bottom-Top sequence The views are shown according to the bottom-top
sequence.

Destinations

The group is active only when you employ the ds parameter.

option description

Print destinations Adds to the report the list of destinations ds. The des-
criptions are taken from Destination Grid.

Use ds color The package is rendered with the color assigned to the
destination.

Document Header

The various options let you customize the headings in the document.
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option description

Print manifest header Prints the two text fields and the date of the document.
The labels of the text fields can be customized in the
Report tab of the Preferences dialog. If data is imp-
orted via ODBC, the strings can be imported from the
fields g desc, g rif and g date of pv job table.

With image logo Prints on the document the Company logo, which can
be customized in the Report tab of the Preferences
dialog.

Logo on all pages When checked, the logo is printed on all pages, oth-
erwise only on the first.

Show page header Includes the header line with the date of creation.

Show page footer Includes the footer line with application name and 3dp
filename.

Automatic Export

The command Report → Export Load Plan in

pdf format [Ctrl+E] allows you to aut-
omate creation of the report. Beside the
standard groups of controls, the dialog has
tools to be used in the case of multi-container
solutions.

Container Range allows to limit the range of
containers to be included into the report;

One file for each container breaks the rep-
ort into multiple files, one for each container.
The file names are created by adding to the
name chosen by User a progressive suffix.

Manual procedure

The manual procedure is started with the command Report → Load Plan in pdf

format → Manual creation and allows the User to choose in real time the layout
and to acquire partial views of the load as desired in case of dynamic layout. When
it opens, the window takes up all the available space, with a panel on the left that
contains controls used to define the Layout. The toolbar is replaced by a specialized
toolbar. Under the toolbar there are fields used for headers and date formatting.
In case of a solution with multiple containers, to start the creation you need to first
select the container you are interested in from the drop-down menu of the Auxiliary
Toolbar.
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Command Description

Auto Automatically generates the report given the current layout
settings.

Back Removes pictures from the visualization.

Next Adds pictures from the visualization.

Snap Creates a partial view (“snapshot”). The partial views are
added to the report.

The drop-down menu shows the list of partial views, which can
be large in number for complex solutions. By selecting a num-
ber, all views up to said number are automatically displayed.
This way, you can quickly create the relation without having to
go through the Next and Back commands.

Cancel Destroys the snapshots and restarts the procedure.

Save saves the report in pdf format.

Close Closes the panel.

No other action is necessary for static lay-
outs. For dynamic ones, the two Next and
Back buttons are used to add / delete partial
views to current view. The Snap command
adds the view to the Load Plan document.
The captured visuals are briefly reported un-
der the work view as a reminder. You can
save the document at any time, there is no
need to complete the process.

Excel Export

Work data can be exported onto Excel files at any time, using the menu command
File → Export (Excel). The available format is xls or xlsx, as desired. The generated
file contains only one sheet, if non-optimized data is being exported, or multiple
sheets in case of verified solutions.

First sheet

First sheet always contains the input data formatted according to master data
format so that you do not have to distinguish between input and output file.
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Second sheet

Second sheet contains general information on the load list

col. header description

A Cont. Nr Container Index, it follows the numbering of the Output Tab. For

all items not loaded, the program uses a fictitious container with index 0.

Cells of these items are rendered with yellow background.

B ID Item ID. The values follow the numbering of the Package Panel.

C Loaded Number of items ID loaded into container Cont. Nr.

D Total Quantity of items.

E Length Package length.

F Width Package width.

G Height Package height.

H Weight Package weight.

I Code Package code.

J Desc. Description of the package.

K Qt/b “number of objects”.

Following sheets

The program creates one sheet for each optimized container that enters the solution.
Each sheet contains four sections

1) summary data of volume / weight occupancy;

2) container load list with the following fields

col. header description

A Cont. Nr Container index, identical for all rows and equal to the number of

the sheet name. The value follows the numbering of the Output

Tab.

B ID Item ID. The values follow the numbering of the Package Panel.

C Loaded Number of items ID loaded into the container.

D Quantity Quantity of items.

E Length Package length.

F Width Package width.

G Height Package height.

H Weight Package weight.

I Code Package Code.

3) load plan summary image

4) list of geometric positioning information as per the following table

col. header description

A ID Item ID. The values follow the numbering of the Package Panel.
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col. header description

B pos position of the item according to the application encoding.

C vert L length “low” coordinate.

D vert W width “low” coordinate.

E vert H height “low” coordinate.

F side L length side.

G side W width side.

H side H height side.

ODBC Export

The command File→ Export (ODBC) [Ctrl+Shift+S] exports the solution data to the
external data source, using the exchange tables as described in the ODBC Tables
section. You can enable the automatic creation of report files during export by
configuring the dialog opened by pressing the Open button of the ODBC Tab in the
configuration window Database → Configure database .

The dialog has the following groups of controls

Working folder: the command Change
allows you to choose a job folder where the
program can create the files. The program
must have write permission on this fol-
der.

Environment variable for identity: allows
you to choose the environment variable
%COMPUTERNAME% or %USERNAME%
when registering in pv job.g userID field
the export operation.

File creation: the set of options carries a
list of the various type of files that can be
exported. Check an item to enable the cre-
ation of the corresponding file. Deselect

all the options if you do not want to use the automatic export.

Automatic filename format: the file name is assigned by the program by combining
the fields of the group. The box g desc refers to the field of the table pv job.

Error Handling: the set of options allows you to define the behavior of the program
when the working folder is not accessible.

Logging configuration: the controls allow you to save the solution in the database
(pv job.g sersol field) and to enable ODBC operation logging. If the latter is active,
the ˜pvODBC import.log, ˜pvODBC export.log and ˜pvODBC tables.log files for
recording import, export and table creation operations are created in the User’s
temporary folder.
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Excel import layouts

Master Data layout

The format of the Excel file, with or without header row at your choice, is described
in the following table.

col. type description value tab

A integer number of packages integer ≥ 0 Dim.

B integer package length integer > 0 Dim.

C integer package width integer > 0 Dim.

D integer package height integer > 0 Dim.

E text alphanumeric code (primary key in the case

of import into internal database)

text Dim.

F integer number of “objects” per package integer > 0,

[1,default]

Box

G float package weight float ≥ 0 [0,

default]

Box

H text description text Desc.

I integer /

text

destination index or name; the zero value or

the empty cell excludes the constraint

[0,default] List

J integer allowed positions; for empty cell, the value is

taken from the default as set in the Preferen-

ces

[1-63], [3,def-

ault]

Pos.

K integer floor only; the zero value or the empty cell

excludes the constraint

[0-63], [0,def-

ault]

Pos.

L integer top-only; the zero value or the empty cell

excludes the constraint

[0-63], [0,def-

ault]

Pos.

M integer not at floor; the zero value or the empty cell

excludes the constraint

[0-63], [0,def-

ault]

Pos.

N integer max stacking; the zero value or the empty

cell excludes the constraint. The value is

global and applies to all sides

integer ≥ 0,

[0,default]

Pos.

O integer stack index; the zero value or the empty cell

excludes the constraint. The value is global

and applies to all sides

integer ≥ 0,

[0,default]

List

P float max bearing weight; the zero value or the

empty cell excludes the constraint. The

value is global and applies to all sides

float ≥ 0,

[0,default]

Pos.

Q integer minimum number; the zero value or the

empty cell excludes the constraint

integer ≥ 0,

[0,default]

List



packVol 3.8.6 - User Guide - 93

col. type description value tab

R integer batch; the zero value or the empty cell

excludes the constraint

integer ≥ 0,

[0,default]

Box

S text set load alphanumeric label. Packages of

a set group must have the same non-blank

label

[’ ’,default] Box

T integer matching code; the zero value or the empty

cell excludes the constraint

integer ≥ 0,

[0,default]

List

U integer forklift handling [0-63], [0,def-

ault]

Handl.

V integer columnar order [0-7], [0,def-

ault]

Handl.

W integer max overhang; the zero value or the empty

cell excludes the constraint

[-1,default] Handl.

X integer empty space, length side [0,default] Space

Y integer empty space, width side [0,default] Space

Z integer empty space, height side (spH ≥ 0) or ab-

solute reference (spH < 0)

[0,default] Space

AA integer max height; the zero value or the empty cell

excludes the constraint

integer ≥ 0,

[0,default]

Pos.

AB integer package color (black=0, white=255255255);

a negative value or the empty cell assigns a

random color

[-1,default] Desc.

AC text optional description text Desc.

AD integer type box [0] or base height for type plt if >
0

[0,default]

AE text reserved

AF integer max depth [-1,default] Handl.

Code / quantity layout

The data layout of the Excel file, which may or may not show the header row, requ-
ires only the first two fields. The others, optional, are used to validate fields that
are not in the database or to replace them.

col. type description value tab

A text code as stored in the internal database. Dim.

B integer number of packages integer ≥ 0 Dim.

C integer destination integer ≥ 0 List
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col. type description value tab

D integer minimum number integer ≥ 0 Box

E integer stack index. The value is global and applies

to all sides

integer ≥ 0 List

F integer container “matching code” integer ≥ 0 List

Dynload additional fields

col. type description value tab

J text family [optional] Box.

K integer number of objects per package [optional] integer > 0 Box.

Stack matrix layout

The first four fields of the Excel file layout, which may or may not contain the header
row, are required. The optional E field has the same meaning as the g status field
of the pv stack table to which we refer.

col. type description value tab

A text lower item code

B text upper item code

C integer position [1-63] of the lower item integer > 0

D integer position [1-63] of the upper item integer > 0

E integer control variable, optional

Container data layout

col. type description value

A text row identifier, container [cnt] or unusable space

[rect, bbox]

[cnt, rect, bbox]

B integer length “low” coordinate integer ≥ 0

C integer width “low” coordinate integer ≥ 0

D integer height “low” coordinate integer ≥ 0

E integer length [cnt,rect]

or “high” length coordinate [bbox]

integer > 0

F integer width [cnt,rect]

or “high” width coordinate [bbox]

integer > 0

G integer height [cnt,rect]

or “high” height coordinate [bbox]

integer > 0

H text container name (only for [cnt] rows) text

I float max load (only for [cnt] rows) float
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col. type description value

J integer default max overhang parameter (only for [cnt]

rows)

integer [0-49]

K integer preferred loading sequence, rear-front [0], bottom-

top [1], layer-front [2] (only for [cnt] rows)

integer

L integer number of containers. integer

Dynload additional fields

col. type description value

M text container type [box, plt]

N integer base height integer ≥ 0

O float tare weight of the container float

Column A must bear the row label. Possible values are:

value description

cnt Container row. Columns B, C, D should be set to zero. In col-
umns E, F, G you enter the internal dimensions of the container.

rect Unusable space row. Columns B, C, D are the “low” coordi-
nates, E, F, G are the edges.

bbox Unusable space row. Columns B, C, D are the “low” coordi-
nates, E, F, G are the “high” coordinates.

Other columns are validated when exporting from the database. The Dynload vers-

ion uses the rule label to hold information about primary containers. This data is not

intended for modification and is not documented.

The rear of the container is assumed near the origin of the axes. Please take this con-

vention into account when defining a container with unusable spaces.

Example

A B C D E F G

cnt 0 0 0 1372 249 297

rect 0 0 0 384 249 35
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ODBC tables

packVol uses the following exchange tables for ODBC import/export operations.
The tables can be automatically created using the Create command in the ODBC
Configuration dialog. For a basic usage you only need to enter the few fields flagged
as not null and shown in bold.

Table use description

pv job In/Out The table is used to define the input load list.

pv sku Input Packages
This is the main table where you can define the input list

of items.

pv cnt Input Containers
It allows you to define the types of containers to be used.

pv obs Input Unusable spaces
It allows you to define the possible unusable spaces of the

container.

pv stack Input Stack matrix
It is used to define exceptions to the stacking rules between

pairs of packages.

pv exec Config Execution parameters
The table is optional and contains the main execution

parameters for the optimization of the input list.

pv report Config Report parameters
The table contains the parameters for formatting of the

reports. It is not used in the desktop version.

pv bin Output Container list
Lists the actual containers used in the solution.

pv geom Output Geometry output table
Describes the geometry of the load plan.

pv desk sku Output Minimal package table
Package auxiliary table, desktop version only.

pv desk cnt Output Minimal container table
Container auxiliary table, desktop version only.

pv desk to job Output Correspondence table
Desktop version only.

For the two parallel tables pv exec and pv report the application selects the record with

g job = pv job.ID. If the record is not found, the application selects the record with

g job = -1. If not found, the application finally assigns default values. You can thus set

the record with the key g job = -1 as the default record.
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Table pv job

The record defines the unique identifier of the input load list.

The primary key is employed in all other tables to filter the records you want to import

and to assign a unique code to the exported records.

field description type value

ID primary key

Zero and negative values are reserved

integer not null integer > 0

g desc description (optional, assigned to the first line of

the header in the pdf report)

varchar(255) text

g rif optional description (optional, assigned to the

second line of the pdf report)

long text text

g date date (optional, assigned to the date line of the pdf

report). The field is textual, and formatting of

the date is free.

varchar(64) text

g userID user string (optional) varchar(255) text

g timestamp last access timestamp integer integer

g barcode UNUSED varchar(24) text

g opt date UNUSED varchar(64) text

g status status: [0] not assigned, [1] assigned, [2]

completed.

integer [0, default],

[1], [2]

g sersol serialized solution (output only) long text text

g date In command line versions, the reserved word AUTO can be used to aut-
omatically format date and time in generated reports.

g userID, g status The desktop application checks if the record has g status = 2
(completed work), or g status = 1 (assigned work) but g userID not empty and
g userID ̸=%COMPUTERNAME% (work assigned to another seat). If these condit-
ions are meet, the import process is stopped. Otherwise, the application sets g status
= 1 and stores in g userID the environmental variable %COMPUTERNAME%. You
can configure system to use the environmental variable %USERNAME% instead of
%COMPUTERNAME%. See the ODBC Export dialog.

The command line versions don’t use this filtering mechanism and only set g userID =

%COMPUTERNAME%, g status = 1 for logging purposes. You can avoid updating of

g userID and g status by setting g assign job = 0 in pv exec table.

Table pv sku

The table is employed to enter the packages of the load list.
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field description type value

ID primary key

Zero and negative values are reserved

integer not null integer > 0

g job unique identifier of the input list (reference

to the key pv job.ID)

integer not null integer

g code alphanumeric code (the primary key in the case

of import into internal database)

varchar(64) text

g total number of packages, or number of objects if

“load by objects” is enforced.

integer not null integer ≥ 0

g length package length integer not null integer ≥ 0

g width package width integer not null integer ≥ 0

g height package height integer not null integer ≥ 0

g ps allowed positions integer [1-63], [3,default]

g fl floor only integer [0-63], [0,default]

g nt top only integer [0-63], [0,default]

g nf not at floor integer [0-63], [0,default]

g qtb number of “objects” per package integer integer> 0, [1,def-

ault]

g btype Desktop STANDARD version only. Type

box [0] or base height for type plt if > 0

integer [0,default]

g dsc description varchar(128) text

g grp optional description varchar(64) text

g wgh package weight float decimal ≥ 0 [0,

default]

g mbe01 max stacking position 1; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mbe02 max stacking position 2; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mbe04 max stacking position 4; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mbe08 max stacking position 8; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mbe16 max stacking position 16; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mbe32 max stacking position 32; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mht01 max height position 1; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mht02 max height position 2; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mht04 max height position 4; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]
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field description type value

g mht08 max height position 8; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mht16 max height position 16; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mht32 max height position 32; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g stk01 stack index position 1; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g stk02 stack index position 2; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g stk04 stack index position 4; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g stk08 stack index position 8; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g stk16 stack index position 16; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g stk32 stack index position 32; null or zero value

excludes the constraint

integer integer≥ 0, [0,def-

ault]

g mxp01 max bearing weight position 1; null or zero

value excludes the constraint

float decimal≥ 0, [0,def-

ault]

g mxp02 max bearing weight position 2; null or zero

value excludes the constraint

float decimal≥ 0, [0,def-

ault]

g mxp04 max bearing weight position 4; null or zero

value excludes the constraint

float decimal≥ 0, [0,def-

ault]

g mxp08 max bearing weight position 8; null or zero

value excludes the constraint

float decimal≥ 0, [0,def-

ault]

g mxp16 max bearing weight position 16; null or zero

value excludes the constraint

float decimal≥ 0, [0,def-

ault]

g mxp32 max bearing weight position 32; null or zero

value excludes the constraint

float decimal≥ 0, [0,def-

ault]

g uml UNUSED integer

g ump UNUSED integer

g lnk group code for set-load; items forming a set

must have the same label.

text [’ ’,default]

g bat batch value; null or zero value excludes the

constraint

integer integer≥ 0, [0,def-

ault]

g ds destination index or name; null or zero value

excludes the constraint

varchar(128) [0,default]

g fml family name; null or blank value excludes

the constraint

varchar(128) [’ ’,default]

g min minimum number or priority; null or zero

value excludes the constraint

integer integer≥ 0, [0,def-

ault]

g hexcol package color in hexadecimal “rrggbb” format

without leading # ; null or blank value

assigns a random color

char(6) [’ ’,default]
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field description type value

g status UNUSED integer

g mc matching code; null or zero value excludes

the constraint

integer integer≥ 0, [0,def-

ault]

g tsplt forklift handling; null or zero value excludes

the constraint

integer [0-63], [0,default]

g clm columnar order; null or zero value excludes

the constraint

integer [0-7], [0,default]

g bover max box overhang; null or a negative value

excludes the constraint

integer [-1,default]

g lsp empty space length side integer [0,default]

g wsp empty space width side integer [0,default]

g hsp empty space height side (spH ≥ 0) or absol-

ute reference (spH < 0)

integer [0,default]

g rfsp UNUSED integer

g ffsp UNUSED integer

g bdepth max depth; null or a negative value excludes

the constraint

integer integer ≥ 0

g length, g width, g height - In desktop versions, when the three values are zero
and g code is not empty, the program checks against the internal database for the
presence of a record with primary key g code. If it is found, the program takes data
from the internal database and eventually replaces all not null fields of the input
row when set.
Command line versions do not implement this “code - quantity” mechanisms and
the three dimensions must be positive.

g qtb, g btype -The fields are employed by the STD and LTE desktop version to
implement the “load by objects” function, if enabled. DYN version never uses this
feature.

In STD command versions “load by objects” is applied whenever g qtb ̸= 1 unless
the rule is disabled in the pv exec.g disable rule field. To use stratification, the g qtb
field must be modified in varchar(128).

g ds - The destination is a numerical index that can be defined directly or deduced
from the textual value. In the latter case the numerical order is progressive with
respect to the first occurrence in the load list. In the desktop version you can set
the preferred rule in the Preferences dialog. In command line versions the rule can
be set in the pv exec.g named filo field. In case g named filo is not set the value is
considered as numeric.

Table pv cnt

The table lists the container types. The list of physical containers is created by the
application by sorting the types according to the ID field and sequentially assigning
the number of physical containers equal to g total. For example, if there are two
records, (ID=1, g job=1, g total=6, g name=’A’) and (ID=2, g job=1, g total=4,
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g name=’B’), the program creates a list of ten containers numbered starting from
one.

A A A A A A B B B B

1 2 3 4 5 6 7 8 9 10 ← value of pv geom.g binID
and of pv bin.ID

field description type value

ID integer primary key integer not

null

integer

g job unique identifier of the input list (reference

to the key pv job.ID)

integer not

null

integer

g name container name (primary key in the case of

import into internal database)

varchar(64)text

g total number of containers integer integer > 0

g length container internal length integer integer > 0

g width container internal width integer integer > 0

g height container internal height integer integer > 0

g type container type, closed [0], open [1], rack

[3]

integer [0, default], [1],

[3]

g bottom top preferred loading order, rear-front [0],

bottom-top [1], layer-front [2]

integer [0, default], [1],

[2]

g max overhang default max overhang percentage of a box

when stacked on another

integer [0-49], [8, def-

ault]

g maxLoad container max load; null or a negative

value excludes the constraint

float decimale ≥ 0,

[0, default]

g enforce dens flag to check the longitudinal weight dis-

tribution, yes [1], mean [3], no [default]

integer [0, default], [1],

[3]

g enforce cm check of center of mass enabled, yes [1],

forbid shift [3], no [default]

integer [0, default], [1],

[3]

g c of mLowL lower percentage limit for the center of

mass along g length axis

integer [0-100],

[0, default]

g c of mHigL upper percentage limit for the center of

mass along g length axis

integer [0-100],

[100, default]

g c of mLowW lower percentage limit for the center of

mass along g width axis

integer [0-100],

[0, default]

g c of mHigW upper percentage limit for the center of

mass along g width axis

integer [0-100], [100, def-

ault]

g tareWg [dynload only] float

g pdepth [dynload only] integer

g hrack [dynload only] integer
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field description type value

g lthick [dynload only] integer

g wthick [dynload only] integer

g length over length [dynload only] integer

g width over length [dynload only] integer

g height as load [dynload only] integer

g plflag [dynload only] integer

g uml UNUSED integer

g ump UNUSED integer

g status UNUSED integer

g prof wgh1

( ,2,3,4)

load of first section (to follow the second,

third and fourth section of five possible)

float decimal ≥ 0

g prof len1

( ,2,3,4)

length of first section (to follow the 2nd, 3rd

and 4th section of five possible)

integer integer ≥ 0

The fields g prof * are used to define the profile of a non-uniform load. The example ab-

ove shows the case where the load 10000 kg needs to be divided on a platform of length

1200 cm in three sections. The values of the last section are calculated by subtraction.

g maxLoad =10.000 g length =1.200

g prof wgh1=4.000 g prof len1 =300

g prof wgh2=2.000 g prof len2 =600

Table pv obs

The table is used to enter the unusable volumes of a container.

field description type value

ID integer primary key integer not null integer

g cntID container index (reference to the key

pv cnt.ID)

integer not null integer

g job unique identifier of the input list

(reference to the key pv job.ID)

integer not null integer

g vert L length “low” coordinate integer integer

g vert W width “low” coordinate integer integer

g vert H height “low” coordinate integer integer
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field description type value

g length length side integer integer

g width width side integer integer

g height height side integer integer

g oflag UNUSED integer

g wgh UNUSED float

Example

field value

g vert L 0

g vert W 0

g vert H 0

g length 384

g width 249

g height 35

Table pv stack

The stack matrix sets “exceptions” to the “natural stacking rules”. Each row defines
a rule that allows a stacking otherwise forbidden, or forbids a stacking otherwise
allowed.

field description type value

g job unique identifier of the input list

(reference to the key pv job.ID)

integer not null integer

g btmID ID of bottom package (reference to the

key pv sku.ID)

integer not null integer ≥ 0

g topID ID of top package (reference to the key

pv sku.ID)

integer not null integer ≥ 0

g btmPs position of bottom package integer not null [1-63], [63, def-

ault]

g topPs position of bottom package integer not null [1-63], [63, def-

ault]

g status control flag, optional integer integer

Example

Records of table pv sku

ID g code g ps g nt natural rule

1 AAA 3 0 no rules

2 BBB 3 0 no rules

3 CCC 63 63 nothing on top of CCC
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Records of pv stack

g btmID g topID g btmPs g topPs resulting rule

1 2 63 63 BBB cannot be placed on top of AAA

3 1 63 63 AAA can be placed on top of CCC

1 1 1 2 AAA can be placed over itself only if turned

g status is an optional field to control the required rule

g status > 0 means that the stacking must be allowed. The program checks
the natural rule and allows the stacking if it’s “naturally forb-
idden”, does nothing otherwise.

g status < 0 means that the stacking must be forbidden. The program
checks the natural rule and forbids the stacking if it’s “naturally
allowed”, does nothing otherwise.

g status = 0
or null

is the default choice and lets the program enforcing the ap-
plicable rule.

Table pv exec

The table is employed to assign the execution parameters. Its use in the desktop
versions is optional, as all parameters can be set from the User interface.

field description type value

g job unique identifier of the input list

(reference to the key pv job.ID)

integer not null integer

g max exec time ms max execution time in milliseconds integer integer≥ 0 [9000,

default]

g time resolution precision of the control over execution

time, [0] normal, [2] accurate

integer [0, default], [2]

g cost function cost function, [0] by volume, [1] by

weight.

integer [0, default], [1]

g on optimality stop execution policy, [0] stop execut-

ion, [1] improve, [2] continue.

integer [0, default], [1],

[2]

g solv method solver method: seq-f, seq-a, fst-f, fst-a,

[plt-r, plt-e, plt-s, mbin]

char(12) [’seq-f’, default]

g solv smar parameter needed by the plt-s solver

method.

integer [7090, default]

g priority list priority constraint, [0] no, [1] ds as

priority, [2] min as priority.

integer [0, default], [1],

[2]

g named filo assigns the destination index ds based
on the descriptive string of the field

pv sk.g ds: [0] no, [1] yes.

integer [0, default], [1]
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field description type value

g filo order FI/LO constraint, [0] no, [1] order

in each container, [2] absolute or-

der between consecutive containers,

[3] absolute order without order ins-

ide container.

integer [1, default], [0],

[2], [3]

g with dsmixing max mixing constraint, [0] no, [1] yes. integer [0], [1, default]

g max dsmixing max mixing threshold, integer ≥ 0 or

-1 if not defined.

integer integer

[-1, default]

g max bdepth max depth, integer ≥ 0 or -1 if not

applies.

integer integer

[-1, default]

g block loadable check loading / unloading, [0] no, [1]

yes.

integer [0, default], [1]

g back equil rear balance check, [0] no, [1] yes. integer [0, default], [1]

g assign job writing of g userID e g status in table

pv job: [0] no, [1] yes.

integer [0], [1, default]

g disable rule allows you to disable certain con-

straints even if they are defined.

integer integer ≥ 0

g plane tolerance UNUSED varchar(255)

g crossing par UNUSED varchar(255)

g back face perc face contact percentage. The values is

applied in case g back equil is active.

integer integer ≥ 0 [30,

default]

g check seed Assigns the seed of the random gener-

ator.

integer integer ≥ 0

g solv method defines the optimization criterion.

g max exec time ms. In command line versions, when g max exec time ms = 0 the
application estimates the minimum number of containers needed to hold the load
list. The result is not optimized and must be considered as an upper bound. The
desktop version rounds the value to the closest non-zero time expressed in seconds,
hence the minimum sensible value is g max exec time ms = 1000.

g time resolution is used by the command line versions only.

g check seed is a test option, and it is recommended that you do not set it.

g disable rule is a test option and normally should be set null or zero. The numeric
value is the sum of the following values:

1 - disables bearing checks 2 - disables destinations

4 - disables priority rules 8 - disables stacking checks

16 - disables set / batch load 64 - disables bearing weight

128 - disables container max load 256 - disables “matching code”

512 - disables “load by object”
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Table pv report

The table is used by the command line versions to assign the parameters of the
report. The table is not used by the desktop versions.

field description type value

g job unique identifier of the input list (reference to

the key pv job.ID)

integer not nullinteger

g img layout image layout. The value 0 or null prevents cre-

ation of the images. See section.

integer [0, default]

g img style style of the images, applies if g img layout ̸=
0. See section.

integer [3, default]

g img width image width in pixels (≤ 1200) integer [600, default]

g img height image height in pixels (≤ 900) integer [450, default]

g img type image format. Supported: bmp, png, jpg, tif,

gif, svg

char(3) [png, default]

g xls report Excel file format, xls o xlsx. Blank or null field

prevents the creation of the file.

char(4) xls, xlsx [”, def-

ault]

g pdf layout layout of pdf file. The value 0 or null prevents

the creation of the file. See section.

integer [0, default]

g pdf style style of the pdf report, applies if g pdf layout

̸= 0. See section.

integer [0, default]

g n views number of views, or steps in case of stepped

layouts.

integer [4, default]

g block size size of blocks of identical packages : [0] small,

[1] medium, [2] large.

integer [0, default], [1],

[2]

g htm layout reports in html format. The value 0 or null

prevents creation of the files. See section.

integer [0, default]

g um units metric unit for formatting of reports. varchar(64) [”, default]

g img layout controls the production of images. The value is obtained by summing
up the following flags, that we organize in sections and to which we give a descriptive
name for clarity

view section

1 FRONT RIGHT - view from front-
right

2 FRONT LEFT - view from front-left

4 BACK LEFT - view from back-left 8 BACK RIGHT - view from back-
right

16 PLANAR - planar view
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step section

128 FORCE RESUME - full container
view

256 STEP BLOCK - step images by
blocks

512 STEP LEVEL - step images by
levels

1024 STEP LAYER - step images by
layers

resume section

4096 FULL PLAN - full load plan view

If g img layout is zero or null the program doesn’t create images. Otherwise, the program

first checks for the presence of FULL PLAN and, if the flag is found, produces an im-

age of the complete load plan. Then the program prepares for production of images

of each container entering the solution, checking for the presence of one of the flags

STEP BLOCK, STEP LEVEL or STEP LAYER. For each flag, the program prepares

a step-by-step sequence describing the loading of the container. If the flags are not

found the program creates a single summary image. The actual production of the im-

ages depends on the remaining “view” flags, that can be combined. For each “view”

the program creates an image. If the “view” flags are absent, the program applies

the FRONT RIGHT flag as default. The flag FORCE RESUME allows adding of the

summary image at the end of the step sequences.

g img style controls the style of images. The value is obtained by summing up the
following values

1 - display text 2 - display color

4 - label on single box 8 - color by destination

16 - length sign 32 - front sign

64 - no label on top face

g pdf layout defines the type of pdf report. The possible values are

1 single view layout 2 duo view layout

3 quad view layout 4 planar layout

5 simple layout 6 level layout

7 layer layout

g pdf style controls the production of pdf report. The value is obtained by summing
up the following flags
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1 - simple view by sections 2 - print loading instructions

4 - print summary list 8 - unique code

16 - one file for container 32 - load plan on new page

64 - without input quantity 128 - no package color

256 - no package label 512 - single box label

1024 - label on loaded boxes 2048 - without manifest header

4096 - without page header 8192 - without page footer

16384 - without logo image 32768 - logo image on all pages

65536 - enforce bottom-top sequence 131072 - enforce rear-front sequence

262144 - print “number of objects” 524288 - use FI/LO colors

1048576 - print FI/LO list

g htm style controls the production of reports in html format. The value is obtained
by summing up the following flags

1 - create the resume report 2 - create the distribution report

4 - create the webGL report

g um units sets the metric units. The default is cm. Set g um units=1 if you need
mm.

Table pv bin

The table lists the actual containers used in the solution.

field description type value

ID integer primary key (assigned by the program with

numbering starting from 1)

integer not null integer

g job unique identifier of the input list (reference to the

key pv job.ID or assigned programmatically if pv job.ID

is not coherent)

integer not null integer

g cntID container identifier(reference to the key pv cnt.ID or

to pv desk cnt.ID in case g job is assigned by the appli-

cation)

integer integer

g vol pc container loading percentage float decimal

g sersol UNUSED long text

Table pv geom

The table gives information about the distribution of the packages among the various
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containers and the positions of the items.

field description type value

ID integer primary key (assigned by the application) integer not nullinteger

g job unique identifier of the input list (reference to the

key pv job.ID or assigned programmatically if pv job.ID

is not coherent)

integer not nullinteger

g skuID package identifier (reference to the key pv sku.ID or

to pv desk sku.ID in case g job is assigned by the appli-

cation)

integer integer

g posID position of the item according to the application

encoding

integer [1, 2, 4, 8,

16, 32]

g binID container index (reference to the key pv bin.ID) integer integer

g vert L length “low” coordinate integer integer

g vert W width “low” coordinate integer integer

g vert H height “low” coordinate integer integer

g edge L length side integer integer

g edge W height side integer integer

g edge H width side integer integer

g status UNUSED integer

The following picture shows how input and output tables are related
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Tables pv desk
The special tables pv desk sku, pv desk cnt and pv desk to job are used by the des-
ktop version only and allow exports of data when pv sku or pv cnt are empty or
not coherent. This situation occurs, e.g., when the list is defined by other means
(Excel, using the internal database, open files, direct input, etc.), or User modifies
the imported list. In such cases, on export the application generates a fictitious
negative g job and uses this value to populate the output tables pv bin and pv geom.
At same time, the program populates pv desk sku and pv desk cnt tables assigning
to each record a progressive negative ID.

In case of modification of the imported list, the table pv desk to job keeps track
of the association between the generated negative g job and the original pv job.ID
identifier. The application uses the pv desk xxx version in case of modified input
only and keeps the original pv xxx.ID value for all unmodified records.

Table pv desk cnt

field description type value

ID integer primary key integer not null integer

g job unique identifier of the input list integer not null integer

g name container name varchar(64) text

g length container length integer integer

g width container width integer integer

g height container height integer integer

g maxLoad max load (≤ 0 when not defined) float decimal

Table pv desk sku

field description type value

ID integer primary key integer not null integer

g job unique identifier of the input list integer not null integer

g code alphanumeric code varchar(64) text

g length package length integer integer

g width package width integer integer

g height package height integer integer

g weight package weight float decimal

Table pv desk to job

field description type value

g desk the generated fictitious g job integer integer < 0

g job the original pv job.ID of the imported list integer integer > 0
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Settings and Preferences

Metric Units

The tab is part of the Preferences dialog, but can be opened directly with the menu
command Setting → Metric Units. Here you may define the Metric Units used by
the program and set the accuracy of your data. Possible values are

– Length: mm, cm, m, mil, in, ft;

– Surface: mm2, cm2, m2, sq.in, sq.ft;

– Volume: mm3, cm3, m3, cu.in, cu.ft;

– Mass: kg, lbs, t, ton.

If you don’t fix a choice, the program employs the default values cm (1x), m2, m3, kg.

To enforce data accuracy the program requires integer-valued input without decimal
digits, while it allows for a more conventional formatting of the various reports via
the scale factor. An example should clarify the matter.

Suppose that the sides of a package are 12.7 cm, 14 cm and 23.2 cm. Even though
the employed units are centimeters, accuracy is actually millimeters and input must
be 127, 140 and 232. Output depends on settings.

User data input output output output

mm 1x cm 10x m 1000x

12.7 cm 127 127 mm 12.7 cm 0.127 m

14 cm 140 140 mm 14.0 cm 0.140 m

23.4 cm 234 234 mm 23.4 cm 0.234 m

This scheme forces User to drop the decimal dot and it clearly stresses that the
program never rounds the input, which is left “as is”. The same scheme is employed
for Imperial Units.

A change in the metric convention does not lead to conversion of the input data. The

choice of units must be understood as a way to keep the printing of values, especially

those of volumes, within limits of acceptable size.

Use fractional inches .. formats the data with the fractional format. The drop-down
menu on the side of the control allows you to choose rounding of the fraction.

Preferences

The Preference dialog is activated with the menu command Tools→ Preferences .
It is composed by seven tabs, accessible by clicking on the list placed on the left.
Each tab displays various groups of parameters logically linked among themselves:
Metric, Options, Solver, Container, Import, Advanced, Report.



packVol 3.8.6 - User Guide - 112

Options

The tab allows you to manage the warnings raised by the program and to restore
the state of the application.

command

Prompt for confirmation before
deleting a solution

Enables all warnings that allow you to undo an
action that leads to the deletion of the solut-
ion.

Restore dialog to manage start
solver / change of solution

Restores the dialog which allows you to choose
the type of solver when not defined.

Restore all information message
boxes

Some message box can be hidden by activating
the option “Don’t show this dialog again”. The
option restores all messages.

Restore default grid size settings Resets the size of the panels on the left, and the
size of the grid cells, to their default values.

Lite version

The Lite version carries the Data Options subsection to configure parameters man-
aged in the other versions with the General tab of the database configuration dialog.

command

Protect data loaded from Database or
from Excel.

Enable secondary description field.

Enable “Load by objects” functionality. Show qt/b field in Box grid.

Solver

The panel displays the default that the program uses in case of opening a new do-
cument, or in case of import of data. If you select the option show current values
the panel displays the current settings. To save the shown settings, check the option
save these as default and press Apply.

Container

You can define a particular container as default, forcing the program to aut-
omatically load its data when opening a new document. This feature may be useful if
you work most of the time with the same container. To define the default container,
simply choose the container from the list and press the button Set as default. The
button Reset removes the association.

Two text boxes allow you to set the default values for max box overhang (%) and for
load order.

Import

The options inside the panel allow you to assign some preferences for the import
procedures.
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option

Use “named” destination on
import (ordered by first entry)

If active, the Excel cell, or the ODBC table
field, which carries the destination is consid-
ered alphanumeric. The numerical value of the
parameter ds is assigned progressively based on
the first occurrence of the string. If inactive,
the value is assumed numeric and assigned di-
rectly.

Don’t show row preview on
Excel (ODBC) import

The option allows to skip the preview dialog
shown before importing data.

Assign color to dimensions /
weight

If the color of an item is not defined, assigns
the color based on the size and weight of the
package.

Advanced

Default positions. To avoid too much typing, when entering items manually, the
program automatically sets all positions as allowed, and assigns the value 63 to the
corresponding cell ps of the Constraint tab. You may change the default value by
selecting the proper entry in the drop-down menu. In case you choose the option
other, the value must be typed manually using a numerical code.

Manual Solver options. In manual mode the program tries, whenever possible,
to place a package in a valid position fulfilling all imposed constraints. The three
options

– at lowest possible level (layer packing);

– on top of rear columns (wall packing);

– as decided by the program itself;

suggest to the program how the control points should be searched and tested.

Packages are listed by code or with an alternative label. The combo box Show alter-
nate list by, having options description, dimensions and volume/weight allows you to
choose the alternative label.

Report

The panel shows various groups of controls.

Report customization

Modify current automatic Pdf
export settings

Opens the pdf Export dialog in preference mode.
All values are saved and used as default when form-
atting the pdf documents.
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Report customization

Don’t show input qty on packing
lists

If selected, the input quantities are not included in
the report.

Show code labels on all listed
packages

Displays the code on all groups of packages.

Description label on load plan
image

Allows you to choose the label to be shown on the
package, with options item code, description, [other]
and dimensions.

Show object quantities qt/b and
qt/b total

The options allow you to choose whether to display
in the list the quantities per package qt/b and the
number of loaded objects.

Header captions

Header Captions Allows you to change the caption of the two
header lines and the date format.

Logo and Company name

Logo - Name Allow you to choose the logo image and to add
a Company header to the reports.

Define names of positions Allows you to assign a name to the position ps.
The names are included in the loading instruct-
ions.

Set captions and labels for Engl-
ish reports

Captions and labels are assigned to the report
in English (localized versions only).
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Appendix

Encoding of positions

The parameter ps which describes the allowed positions is encoded with a single
integer obtained by summing up the values in the following table for each allowed
position. The parameters fl, tp and nf are encoded in an analogous manner.

value description

1 reference position: length, width, and height are aligned with length,
width, and height of the container.

2 rotation about the vertical axis of position 1
(swap length ↔ width).

8 the reference position 1 is “lying down” on the width side
(swap width ↔ height).

4 rotation about the vertical axis of position 8
(swap width ↔ height, then width ↔ length).

32 the reference position 1 is “lying down” on the length side
(swap length ↔ height).

16 rotation about the vertical axis of position 32
(swap length ↔ height, then width ↔ length).

81 32

2 164

Knowledge of the position code is needed for all operations related to the automatic

import of data. A special dialog of the Preferences window allows you assign a label to

each position.
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Some examples

When all positions are allowed you set ps = 63 (1+2+4+8+16+32).
For a pallet, which should never be lying on its sides, you need ps = 3 (1+2).
For a freezer, that you want to just lay on a given side, you must force ps = 12
(8+4) or ps = 48 (16+32), according to the definition of the edges.

Coordinates

(0,0,0)

 “low” coordinates

“high” coordinates

length

length

height

The origin of the coordinates
is located at the rear of the
container.

“Low” and “high” coordinates
are those of the vertex closer
and farther from the origin.

Dynload panels

The Dynload version has two read-only summary panels

Primary panel Package distribution

List of items loaded or left on the ground in

the first stage. The grid reports the code,

the destination (zero if absent), the size of

the package, the total quantity, the num-

ber of packages loaded, and any remaining

part to be loaded in the second stage.

Sortable grid of the package distribution.

In the headers ID is the progressive num-

ber assigned by the program, cnt is the

container type, bin is the used container

according to the numbering of the Output

tab (or -1 if left on ground), pk is the num-

ber of loaded packages.
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Rack/Flat container

The container is open from the width
side and has the height equal to the
height of the front wall.

Floor packages are positioned with
symmetrical overhang if they have a

greater extension than the base, while they are positioned according to the value of
Max box overhang (%) in case of lower extension.

Packages not on the floor at a height greater than or equal to the height of the
container wall are never loaded. For intermediate heights, positioning is controlled
by the parameter Min vertical overlap (%).
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Information and License

Please contact us at www.packvol.com for any question about registration, integr-
ation with other applications, or for updates.

License
PACKVOL END USER LICENSE AGREEMENT (“EULA”)

THIS END USER LICENSE AGREEMENT (“EULA”) IS A LEGAL DOCUMENT. IT

PROVIDES A LICENSE TO USE THE SOFTWARE AND CONTAINS WARRANTY INFORM-

ATION AND LIABILITY DISCLAIMERS. BY USING THE SOFTWARE, YOU AGREEING TO

BECOME BOUND BY THE TERMS OF THIS AGREEMENT. READ IT CAREFULLY BEF-

ORE COMPLETING THE REGISTRATION PROCESS.

This End User License Agreement (“EULA”) is a legal agreement between you, the licensee

under this Agreement (either an individual or a single entity), and packVol.com di Angelucci

Dr. Antimo, an Italian sole proprietorship with its place of business at Via Giulia 1, I30026

Portogruaro (VE), Italy, herein referred to as “AUTHOR”, with regard to the computer software

known as packVol herein referred to as “SOFTWARE”, provided with this EULA.

1. TITLE. Title to SOFTWARE and all associated intellectual property rights is retained by

the AUTHOR. This license gives you no rights to such content.

2. LICENSE GRANT. The AUTHOR grants you a non-exclusive and non-transferable license

to install and use the SOFTWARE provided with this EULA.

a) A unregistered copy of the SOFTWARE (“UNREGISTERED SOFTWARE”) may be used by

you for EVALUATION PURPOSES ONLY for a period of thirty (30) days following the initial

installation (“TRIAL PERIOD”). The UNREGISTERED SOFTWARE may be freely copied and

distributed to other users for their evaluation. At the end of the TRIAL PERIOD, you must

either purchase license(s) to register the SOFTWARE or remove it from your system.

b) You may install the registered SOFTWARE on any computer owned by you, provided that

the number of concurrent users does not exceed the number of licenses purchased. This EULA

does not apply to site-wide license, in which case additional or different terms shall apply.

c) You may make a reasonable number of backup copies of the SOFTWARE, provided backup

copies are not installed or used for other than archival purposes.

d) The purchase entitles you to obtain free upgrades for all the upcoming 3.x.x releases of the

SOFTWARE and/or for all the versions released within one year from the purchase.

3. RESTRICTED USE. Unless enforcement is prohibited by applicable law, you may not:

a) remove or obscure logo, copyright, AUTHORS’s proprietary rights notices or any other notice

in or on the SOFTWARE and in or on its associated files.

b) alter, decompile, disassemble or reverse engineer the SOFTWARE or create derivative works

from the SOFTWARE.

c) adapt, rent, lease, loan, resell, or distribute any product derived from the SOFTWARE or

related files including, without limitation, the database support.

d) disclose to any third party any activation key, which is strictly confidential and personal to

you.

https://www.packvol.com
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e) transfer or assign to third parties your rights under this Agreement without the prior written

permission from AUTHOR.

The AUTHOR reserves the right to enforce the terms of this EULA which may at the AUTHOR’s

discretion comprise actions such as license key validation and concurrent access monitoring.

4. DISCLAIMER OFWARRANTY. The SOFTWARE is not intended to be a substitute for prof-

essional judgment and the entire risk as to the quality and performance of the SOFTWARE is

with you. The SOFTWARE is not intended for use in the design or operation of nuclear facilit-

ies, life support systems, aircraft or other activities in which the failure of the SOFTWARE

could lead to death, personal injury, or severe physical or environmental damage. THE

SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND. TO THE

EXTENT PERMITTED BY LAW, THE AUTHOR AND SOFTWARE’S DISTRIBUTORS HER-

EBY DISCLAIM ALL WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING,

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FIT-

NESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. YOU BEAR ENTIRE

RISK AS TO SELECTING THE PRODUCT FOR YOUR PURPOSES AND AS TO THE

QUALITY AND PERFORMANCE OF THE PRODUCT. THIS LIMITATION SHALL APPLY

NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY REMEDY. SOME

JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WAR-

RANTIES, SO THIS DISCLAIMER MAY NOT APPLY TO YOU.

5. LIMITATION OF LIABILITY. EXCEPT AS REQUIRED BY LAW, THE AUTHOR AND ITS

SOFTWARE’S DISTRIBUTORS SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT,

INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,

BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS

OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND

ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR

TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF

THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH

DAMAGE. SOME COUNTRIES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF

INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND EXCLUSION

MAY NOT APPLY TO YOU.

6. INDEMNIFICATION. If you use or distribute the SOFTWARE in violation of this Agreem-

ent, you agree to indemnify, hold harmless and defend THE AUTHOR and its SOFTWARE’S

distributors from and against any claims or lawsuits, including attorney’s fees that arise or result

from the use or distribution of the SOFTWARE in violation of this Agreement.

7. TERMINATION. If you breach any of the terms or conditions of this Agreement your right

to use the SOFTWARE will terminate immediately and without notice, but all provisions of

this Agreement except the LICENSE GRANT (clause 1) will survive termination and continue

in effect. Upon termination, you must destroy all copies of the SOFTWARE and any record of

the activation key.
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